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1. Objetivos propuestos en la presentación del proyecto 

 

La formación en Tecnologías de la Información juega una importancia crucial en el éxito 
de los grados y másteres universitarios. No es de extrañar que entre los estudios que 
cuentan con una fuerte componente territorial haya crecido con fuerza la incorporación 
a los planes docentes de asignaturas sobre Tecnologías de la Información Geográfica. 
Dentro de ellas los Sistemas de Información Geográfica (SIG) son las herramientas más 
usadas. 

A su vez, en el marco de los planes de estudios adaptados al espacio europeo de 
enseñanza superior las actividades no presenciales tienen un peso cada vez mayor. Las 
actividades del estudiante fuera de las aulas son una parte importante de su carga de 
trabajo y, al igual que el trabajo presencial, los tiempos dedicados a estas actividades 
deben ser considerados e incluso medidos.   

En este marco, en este proyecto de innovación nos hemos planteado un doble objetivo 
general en relación con la formación en SIG. Por un lado, recopilar los materiales 
existentes, homogeneizarlos formalmente y generar nuevos materiales para actividades 
no presenciales en la formación en SIG. Por otro, evaluar las cargas de trabajo y el 
grado de satisfacción del estudiante en la realización de esas actividades no 
presenciales, así como los resultados finales para el aprendizaje de SIG.  

Para el cumplimiento de este doble objetivo se establecieron los siguientes objetivos 
específicos: 

1) Consolidar el grado de coordinación del profesorado en asignaturas de SIG en 
las diferentes titulaciones en las que se imparte. 

2) Recopilar los materiales para actividades no presenciales desarrolladas en las 
asignaturas de SIG en las titulaciones de la UCM. 

3) Homogeneizar los materiales para actividades no presenciales en relación a los 
SIG, dándoles un formato didáctico común que permita un mejor rendimiento del 
alumnado y una valoración de las actividades realizadas. 

4) Desarrollar nuevos materiales para actividades no presenciales en asignaturas 
de SIG ya implantadas y en las asignaturas de nueva creación. 

5) Clasificar los materiales de trabajo no presencial del alumno según grados de 
autonomía y dificultad, con el fin de organizar la secuencia de los mismos a lo 
largo del curso. 

6) Conseguir que los propios alumnos/as realicen propuestas de ejercicios y 
materiales de trabajo no presencial utilizando SIG, en temáticas que les sean de 
interés y siempre con amplia vocación creativa. 

7) Generar una ficha de evaluación por parte del alumnado de las actividades no 
presenciales realizadas a lo largo del curso. 

8) Medir y evaluar los tiempos reales (señalados por el alumnado) dedicados a la 
realización de actividades no presenciales en SIG. 

9) Contrastar los tiempos dedicados por los alumnos/as con los tiempos estimados 
por el profesorado de la materia. 

10) Conocer la valoración del grado de dificultad encontrado por los estudiantes en 
las no presenciales y contrastar con los estimados por el profesorado. 
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11) Tener una certeza en la adquisición de las competencias en la formación de SIG 
y mejorar los resultados académicos del alumnado. 

En definitiva, con este proyecto nos hemos planteado como problema fundamental tratar 
de sistematizar y generar material para actividades no presenciales y la evaluación de 
sus cargas de trabajo en materias técnicas en general y vinculadas a los SIG en 
particular.  

 

2. Objetivos alcanzados 

 

Finalizado el proyecto consideramos que los objetivos inicialmente planteados han sido 
alcanzados. Sobre los objetivos específicos planteados se considera: 

Objetivo 1) Aunque existía ya una buena coordinación por parte del profesorado en 
materias de SIG, este proyecto ha permitido consolidar esa coordinación y el trabajo 
conjunto, desarrollando materiales comunes para las asignaturas involucradas. El 
proyecto ha facilitado además la discusión sobre los materiales no presenciales a 
plantear en las clases, la evaluación de las cargas de trabajo de los estudiantes y las 
percepciones que éstos tienen de las mismas.  

Objetivos 2 y 3) El proyecto ha permitido recopilar, homogeneizar y poner en común 
gran cantidad de materiales para actividades no presenciales, que se estaba usando en 
las asignaturas incluidas en el proyecto. Para ello se generó una ficha común, a la que 
se han adaptado los materiales recopilados (ver ejemplo de la ficha y de los materiales 
generados en el Anexo).  

Objetivo 4) Además del material recopilado, se han generado materiales nuevos en 
aquellos bloques temáticos menos cubiertos y en especial en las asignaturas de nueva 
creación. Por ejemplo, se han generado materiales para la asignatura de “Estadística 
Espacial” del Máster de Tecnologías de la Información Geográfica. Estos materiales 
podrán ser usados en una asignatura nueva con un bloque similar que se impartirá el 
próximo curso en el Master de Estadísticas Oficiales e Indicadores Sociales y 
Económicos.  

Objetivo 5) En la primera reunión de coordinación y trabajo se estableció una tipología 
de materiales según la naturaleza de la actividad (guiada, semiguiada o autónoma) y el 
grado de dificultad (alto, medio, bajo) (ver tipología en el Anexo). De esta forma el 
material generado puede ser ordenado y clasificado en el repositorio, y el profesorado 
puede seleccionar de forma fácil los ejercicios que va a suministrar a los estudiantes. 
De la misma manera, los estudiantes saben de partida las características y el grado de 
dificultad estimado por el profesorado de los ejercicios que van a realizar.  

A partir de estas clasificaciones el proyecto ha permitido jerarquizar el trabajo del 
estudiante a lo largo del curso, con actividades en las que se vaya secuenciando su 
nivel de autonomía, desde unas iniciales muy guiadas en el inicio del curso a actividades 
completamente autónomas al final. 

Objetivo 6) En algunos ejercicios abiertos se ha propuesto a los estudiantes a plantear 
sus propios ejercicios, de esta manera se fomenta su creatividad y la búsqueda de 
soluciones imaginativas en el uso de herramientas SIG y se les hace participes de la 
generación de nuevos materiales. 

Objetivo 7) Junto a la ficha de presentación de la actividad se generó una ficha para la 
evaluación de la actividad por parte de los estudiantes (ver ficha de evaluación en 
Anexo). En esta ficha se evalúan aspectos como el “Tiempo requerido real en minutos 
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dedicado a la práctica”, el “Grado de dificultad” o la “Utilidad de la práctica”, que los 
alumnos valoran de 1 a 5, o preguntas abiertas como “¿Has encontrado dificultades en 
la realización del ejercicio? ¿Cómo las has solventado?”. 

Objetivo 8) La ficha de evaluación permite medir y evaluar los tiempos reales (señalados 
por el alumnado) dedicados a la realización de actividades no presenciales. En el 
proyecto se han evaluado las actividades de tres asignaturas impartidas en el segundo 
cuatrimestre. Se han elegido asignaturas que tienen distinto nivel, una de primer curso 
del Grado de Arqueología, otra de tercero del Grado de Geografía y Ordenación del 
Territorio y otra asignatura del Máster de Tecnologías de la Información Geográfica. Los 
datos han sido explotados a nivel de tablas y gráficos y discutidos por el profesorado 
que forma parte del equipo de trabajo (ver algunos ejemplos de resultados en el Anexo). 
Esta información tiene un gran valor para la evaluación de las prácticas planteadas, 
tanto en esas asignaturas como en las restantes asignaturas involucradas en el 
proyecto. 

Objetivo 9) Tras constatar durante cursos previos una alta carga de trabajo por parte del 
alumnado a través de los canales de evaluación (Docentia, Verifica, encuestas 
facultades y másteres), el proyecto ha permitido en consecuencia generar actividades 
para las que se conocen los tiempos reales dedicados por los estudiantes y han sido 
contrastados con los que estimaba por el profesorado y los que han calculado también 
los estudiantes de doctorado que han participado en el proyecto. 

Objetivo 10) De la misma manera que se han contrastado los tiempos, a partir de las 
respuestas facilitadas por los estudiantes se ha evaluado el grado de dificultad que estos 
han encontrado en las prácticas. Esta información ha sido también contrastada con los 
grados de dificultad estimados por el profesorado.   

Objetivo 11) El desarrollo del proyecto, los materiales generados y la información 
recabada de los estudiantes ha permitido tener una mayor certeza de la adquisición de 
las competencias en la formación de SIG. En el momento del cierre del proyecto no es 
posible evaluar si los materiales desarrollados han tenido alguna repercusión en la 
mejorar los resultados académicos del alumnado, pero se ha dado respuesta a una 
demanda habitual de los estudiantes, que en las encuestas que se les realizan en Grado 
y Máster solicitan con frecuencia este tipo de actividades. Estimamos que a la larga la 
realización de este tipo de actividades debe repercutir en la mejora los resultados 
académicos. 

En este sentido, con este proyecto creemos que se han conseguido responder a la 
necesidad de incrementar la valoración del estudiante de las actividades no 
presenciales, con actividades atractivas, aplicadas a la resolución de problemas 
relacionados de forma directa con sus titulaciones, que facilitan el aprendizaje de la 
materia y la adquisición de las competencias con ellas relacionadas, incrementando su 
satisfacción. El proyecto ha tenido un impacto directo sobre 11 asignaturas, de 5 
titulaciones diferentes. Además al tratarse de asignaturas instrumentales consideramos 
que el proyecto va a repercutir también en los Trabajos Fin de Grado y Fin de Máster y 
en las Prácticas en Empresas, donde los estudiantes usan con frecuencia este tipo de 
herramientas.  

 

  



6 
 

3. Metodología empleada en el proyecto 

 

Para el desarrollo del Proyecto de Innovación se propusieron 8 fases de trabajo. A 
continuación se enumeran y describen brevemente las actividades realizadas en cada 
una de las fases: 

1) Planificación de actividades. Se llevaron a cabo tres reuniones de coordinación 
en la que participaron todos los miembros del equipo. Además, los profesores 
de asignaturas comunes o similares trabajaron de forma conjunta y con el 
coordinador del proyecto. 

2) Recopilación de materiales y actividades no presenciales en las asignaturas de 
SIG. A partir de un directorio compartido con todo el equipo en Google Drive de 
la UCM se ha construido un repositorio donde el profesorado ha depositado el 
material, clasificado según las asignaturas involucradas y con dos subcarpetas: 
a) “Materiales de partida” (que se estaban usando en cada una de sus clases) y 
b) “Materiales nuevos”. 

3) Selección de materiales, homogeneización y fichas para la valoración de las 
actividades. Se ha creado una ficha y una plantilla para la homogeneización del 
material recopilado. Posteriormente se han adaptado los materiales una vez 
seleccionados para el desarrollo de las actividades no presenciales. Estos 
materiales adaptados a la ficha fueron guardados en la carpeta de Drive de 
“Materiales nuevos”. 

4) Desarrollo de nuevos materiales y actividades. A partir de los materiales 
recogidos se han detectado algunos campos sin cubrir y se han desarrollado 
nuevos materiales. Así, por ejemplo, se han creado ejercicios de edición y 
recogida de datos, análisis de redes o estudios ambientales. 

5) Implementación de los materiales y actividades en las asignaturas. Los 
materiales elaborados se han implementado en tres asignaturas del segundo 
cuatrimestre. Las asignaturas elegidas tienen distinto nivel (en primer curso y 
tercero de Grado y en Máster) y en consecuencia distinto grado de 
especialización. Eso permite valorar los materiales en función de tipologías de 
alumnos muy diferentes. 

6) Evaluación de las valoraciones realizadas por los alumnos a las actividades 
propuestas. Los resultados de las valoraciones han sido trabajados en una base 
de datos Excel y analizadas por el equipo de la propuesta. En el anexo de esta 
memoria se presentan los resultados básicos de las valoraciones de los 
alumnos.   

7) Propuestas de mejora para la aplicación de los materiales y actividades en 
futuros cursos. A partir de los resultados del proyecto, el equipo de trabajo ha 
realizado una propuesta de uso de materiales no presenciales en las 
asignaturas. Se propone también implementar los materiales elaborados en el 
próximo curso y en todas las asignaturas incluidas en el proyecto. 

8) Difusión de los resultados del proyecto de innovación. Se pretende difundir los 
materiales generados en congresos y publicaciones de didáctica.  
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4. Recursos humanos  

 

El equipo de trabajo ha estado compuesto por 7 profesores/as, 1 docente-investigadora 
y 3 estudiantes de doctorado. Todos ellos han tenido el máximo grado de implicación 
con las actividades realizadas, participando en las reuniones de trabajo y coordinación 
y en permanente contacto con el responsable del proyecto y los responsables de las 
diferentes fases o actividades. Como se ha señalado en los apartados 1 y 2 de esta 
memoria, uno de los objetivos del proyecto era incrementar el grado de coordinación del 
profesorado en asignaturas de SIG en las diferentes titulaciones en las que se imparte. 

El responsable de proyecto ha sido el profesor Juan Carlos García Palomares. Tenía 
experiencia previa en 2 proyectos de innovación docente en la convocatoria de 2015 y 
tiene evaluaciones positivas en el programa DOCENTIA todos los años desde 2012, con 
evaluación “Excelente” en los últimos cursos (2014/2015 y 2015/2016). Tiene 
experiencia en gestión universitaria: actualmente es coordinador del Máster de 
Tecnologías de la Información Geográfica, ha sido Secretario Docente de Departamento 
y es miembro de la Comisión Académica del Grado de Geografía y OT y del Doctorado 
de Geografía. 

Los profesores miembros del equipo han sido Javier Gutiérrez Puebla (Catedrático), 
Juana Rodríguez Moya (Profesora Titular), Carmen Mínguez García (Profesora 
Contratada Doctora), Nuria de Andrés de Pablo (Profesora Titular Interina), Luis Miguel 
Tanarro García (Profesor Contratado Doctor) y Miguel Vía García (Profesor Asociado). 
Todos los profesores tienen una docencia muy amplia en SIG en las titulaciones 
adaptadas al EEES desde su implantación. Han sido evaluados positivamente en 
DOCENTIA y han participado en proyectos de innovación docente (en algún caso como 
responsables). El profesorado del equipo ha compartido docencia en muchas 
asignaturas y forma parte de comisiones de coordinación y calidad comunes, lo que 
facilitado la buena integración y coordinación entre ellos. 

Junto al profesorado, en el proyecto han jugado un papel fundamental los investigadores 
y doctorando participantes. Henar Salas Olmedo, que ha participado como investigadora 
Juan de la Cierva, ha tenido un papel importante de apoyo en tareas de coordinación 
del proyecto. Los doctorandos Borja Moya, Gustavo Romanillos, Joaquín Osorio y José 
María Fernández Fernández han participado con intensidad en la creación de nuevos 
materiales en la valoración, en la evaluación de los materiales por parte del equipo y en 
el apoyo general al proyecto. 

 

5. Desarrollo de las actividades 

 

El desarrollo del proyecto se ejecutó en las 8 fases de trabajo propuestas en la 
metodología, en el marco de las cuales se desarrollaron las siguientes actividades: 

Fase 1: Planificación de actividades.- Como se ha mencionado esta fase se desarrolló 
a partir de una primera reunión general del equipo de trabajo, en la que participaron los 
miembros del equipo. El objetivo fue la coordinación de las primeras actividades y los 
primeros trabajos. El responsable de esta fase fue el coordinador del proyecto y en ella 
participó todo el equipo. En concreto, las actividades desarrolladas fueron: 

Actividad 1.1) Presentación de la recopilación de los materiales para actividades no 
presenciales ya existentes. 
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Actividad 1.2) Elaboración de un formato de ficha para la homogeneización de los 
materiales y su evaluación.  

Actividad 1.3) Definición del número y tipo de nuevos materiales a desarrollar. 

Actividad 1.5) Planificación de las herramientas necesarias en el campus virtual 
para el desarrollo y seguimiento de las actividades. 

Fase 2: Recopilación de materiales.- Esta fase se dedicó a la recopilación del material 
existente. Nuevamente la actividad fue coordinada por el responsable del proyecto y 
contó con la participación de todo el equipo. Esta fase se realizó a partir de una única 
actividad: 

Actividad 2.1) Recopilación de los materiales ya existentes.  

Fase 3. Homogeneización de materiales y fichas para la valoración de las actividades.- 
Esta fase fue coordinada por Juan Carlos García y Henar Salas. Se desarrolló a partir 
de tres actividades: 

Actividad 3.1) Homogeneización de los materiales según la ficha común. 

Actividad 3.2) Elaboración de una ficha para la evaluación de tiempos y cargas de 
trabajo de las actividades por el alumnado y profesorado. 

Actividad 3.3) Recopilación de los materiales finales y creación de una base de 
datos con las valoraciones del profesorado. 

Fase 4: Desarrollo de nuevos materiales y actividades.- A partir de los materiales 
existentes se detectaron algunas carencias en los programas, y se realizaron nuevos 
materiales para cubrirlas. Las actividades desarrolladas en esta fase, coordinada por 
Juan Carlos García y Henar Salas y con la participación de todo el equipo, fueron:  

Actividad 4.1) Reunión de coordinación para la presentación del material recopilado 
en la fase 3. 

Actividad 4.2) Detección de carencias, propuestas de nuevos materiales y reparto 
de materiales a desarrollar entre los miembros del equipo. 

Actividad 4.3) Elaboración de nuevos materiales. 

Actividad 4.4) Recopilación de los nuevos materiales e integración de las 
valoraciones del profesorado en la base de datos. 

Fase 5: Implementación de los materiales en las asignaturas.- Esta fase se desarrolló 
tres asignaturas del 2º cuatrimestre. Por un lado se tomó la asignatura de introducción 
al SIG en el Grado de Arqueología, por otro SIG II del Grado de Geografía y Ordenación 
del Territorio y por otro de Aplicaciones de las TIG en estudios urbanos en el Máster de 
TIG. En ellas las actividades se fueron activando de forma secuencial, siguiendo el 
cronograma previsto en el programa. Los participantes fueron Juana María Rodríguez 
Moya, Carmen Mínguez, Miguel Vía, Henar Salas, Borja Moya, Gustavo Romanillos y 
Juan Carlos García Palomares. Las actividades concretas desarrolladas fueron:  

 Actividad 5.1) Presentación al alumnado el material y la metodología de trabajo 
para el desarrollo de actividades no presenciales. 

Actividad 5.2) Realización de las actividades no presenciales, valoración del 
alumnado y seguimiento del profesorado. 

Actividad 5.3) Evaluación de las actividades y recogida de información sobre los 
tiempos y las valoraciones realizadas. 
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Fase 6: Evaluación de las valoraciones realizadas por el alumnado a las actividades 
propuestas.- Para las asignaturas anteriores, en esta fase se realizó la valoración de las 
cargas de trabajo, la satisfacción y los resultados de aprendizaje a partir de los 
resultados obtenidos en las fichas de evaluación completadas por los estudiantes: 

Actividad 6.1) Análisis de la base de datos con las valoraciones y tiempos del 
alumnado y profesorado, y elaboración de indicadores. 

Actividad 6.2) Elaboración de informe parcial de los resultados. 

Actividad 6.3) Revisión de los materiales elaborados en función de los resultados.  

Fase 7. Propuestas de mejora para la aplicación de materiales en cursos futuros.- A 
partir de los resultados y los indicadores obtenidos, y de la experiencia en las fases 
previas, se obtuvieron unas conclusiones finales, que ponen el acento en realizar 
propuestas de mejora para futuros cursos. Las actividades realizadas fueron:  

Actividad 7.1) Puesta en común de los resultados y propuestas de mejora. 

Actividad 7.2) Redacción del documento final. 

Fase 8: Difusión de los resultados del proyecto de innovación.- Esta fase está en 
desarrollo y se espera obtener los resultados a partir de la explotación y síntesis del 
trabajo hasta ahora realizado. El objetivo planteado es la publicación de los resultados 
del proyecto en foros y congresos de innovación docente, así como en publicaciones de 
referencia en este campo como “Cuadernos de Didáctica de la Geografía”.  

 

 

 

 

 

 

 

  



6. ANEXOS  

 

Anexo 1: Ficha para la presentación de las actividades: 

PRESENTACIÓN DE LA ACTIVIDAD 

Título:  

 
Presentación:  
 

Objetivo/s:   
 

 
Actividades a realizar:  

 
 
 

 
Periodo de realización:   
 

 
Tiempo requerido (estimado profesor):   
 

 
Grado de dificultad (estimado profesor):  
 

 

  



 

Anexo 2. Clasificación de los materiales de trabajo no presencial según grados 

de autonomía y dificultad 

1. Ejercicios guiados  

2. Ejercicios semi-guidados (ejemplo prácticas) 

3. Ejercicios autónomos 

 

A. Dificultad baja 

B. Dificultad media 

C. Dificultad alta 

 

Tipología establecida: 

 Baja Media Alta 

Guiados A   

Semiguiados B C D 

Autónomos  E F 

  



 

Anexo 3. Ficha de Valoración de la actividad por parte de los estudiantes: 

 

VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 

  



 

Anexo 4. Ejemplos de ejercicios guiados 

 

  



 

PRESENTACIÓN DE LA ACTIVIDAD 

Título: Análisis de las pautas de localización de elementos 

puntuales: localización de locales de actividad en Madrid 
 

Presentación: Se trata de un ejercicio guiado en el que se van a utilizar las herramientas de 

Análisis de las pautas de localización incorporadas en ARCGIS para analizar la distribución de 

la actividad económica en el centro de la ciudad de Madrid 

Objetivo/s:   

Familiarizar al alumno con las herramientas de análisis de patrones de pautas de localización  

 

Actividades a realizar: 

 Análisis de las pautas de localización de los locales de Madrid. 
 

 Cálculo del centro medio.  

 Calculo de la distancia estándar 

 Cálculo del centro de gravedad y la elipse de variabilidad 
 

 Cálculo del vecino más próximo 
 

 Determinar la localización de “hot spots”. 
 

 Cálculo del valor Getis-Ord para el conjunto del área de estudio 

 Cálculo del valor Getis-Ord para cada punto 
 

 

Periodo de realización:  1:30 horas 

 

Tiempo requerido (estimado profesor):  1:30 horas 

 

 

Grado de dificultad (estimado profesor): Baja (Tipo A) 

 



VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 

Tiempo requerido (real, minutos dedicados a la práctica): 

 

 

Grado de dificultad (Valoración de 1 a 5): 

 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 

1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 

 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 

 

 



Ejercicio Guiado: Análisis de las pautas de localización de los locales de 

Madrid. 
 
En este ejercicio vas a trabajar con las capas de Restaurantes.shp y de Farmacias.shp. Sobre ellas 
vas a realizar una descripción de sus localizaciones a partir de las estadísticas geográficas  
básicas, como son el centros medio y la distancia estándar o la ponderación de los mismos 
(centro de gravedad y radio dinámico) usando en este caso como factor de ponderación el 
número de trabajadores de los locales. Estas estadísticas geográficas nos dan una visión genérica 
inicial de la localización de variables puntuales, de manera que podemos conocer por ejemplo 
si la localización es más o menos homogénea en el área de estudio (de manera que los centros 
se localizaran en los espacios centrales) o si por el contrario, la localización de los elementos 
puntuales se encuentra más concentrada en un determinado sector (de manera que los centros 
medios tenderán a desviarse hacia ese espacio. A la vez, la distancia estándar o el radio dinámico 
dan una imagen de la mayor o menor concentración alrededor del centro medio o de gravedad.  
 
Paso 1. Cálculo del centro medio.  
 
Abre una sesión nueva de ArcGIS, para partir de una sesión nueva de trabajo y despliega las 
capas de Panaderías.shp, AsesoríasJurídicas.shp y Distritoscentro.shp. Acomoda la visualización 
de las capas de forma que puedas observar sus pautas de localización de manera más clara. 
Puedes poner por ejemplo las panaderías con un símbolo de color marrón oscuro y las asesorías 
con un azul. Quita el fondo de la capa de distritos. Como vimos en el ejercicio anterior, las 
panaderías tienen una distribución mucho más homogénea sobre los 5 distritos, mientras las 
asesorías tienden a concentrarse en el distrito de Salamanca. 
    
 
 

Panaderías 

 

Asesorías Jurídicas 

 
 
ArcGIS incorpora una serie de herramientas dentro del módulo de ArcToolbox, que permiten el 
cálculo de las estadísticas geográficas básicas. Para ello, debes abrir el módulo de ArcToolbox 

pulsando en el icono  que te aparece en el panel superior. Veras como se despliega una 
ventana de herramientas contigua al panel de contenidos. Dentro de las ArcToolbox, abre las 
Herramientas de Estadísticas Espaciales (Spatial Statistics Tools) > Medidas de Distribución 
Geográfica.  



 
 

Tienes dos opciones a la hora de calcular el centro medio. Por un lado, la opción Centro Medio 
(Mean Center) que devuelve un punto con la localización del centro medio de la capa de puntos 
(con capas de líneas o de polígonos trabaja usando los centroides de líneas o polígonos. Por otro 
lado, la opción Figura Central (Central Feature) devuelve el punto de la capa sobre la que 
estamos trabajando que está en la posición más cercana al centro medio (en nuestro caso, si 
trabajamos con Panaderías nos daría la localización de la panadería que se encuentra más cerca 
del centro medio).  
 
Vas a calcular el centro medio de la distribución de panaderías y asesorías. Para ello, doble clip 
sobre Mean Center. Como capa de entrada (1) utiliza en primer lugar Panaderías.shp. El centro 
medio va a ser un punto en una capa nueva, almacena esta capa de salida (2) en tu directorio 
\prácticas con el nombre CentroPanaderías. Fíjate que podríamos introducir (3) un campo de 
ponderación a la hora de calcular la posición, de manera que diéramos un peso distinto a cada 
uno de los puntos en función de una variable de la base de datos. En nuestro caso podríamos 
introducir el número de trabajadores (no obstante, ahora deja este campo en blanco, lo harás 
más adelante). Además, es posible calcular varios centros medios para una capa (4) en función 
de una tipología que esté introducida en un campo de la capa de puntos. Por ejemplo, podríamos 
calcular un centro medio para las panaderías distinto en función de la fecha de apertura o de 
una tipología de panaderías. Finalmente, (5) permite incluir un valor en la tabla de atributos del 
centro medio que obtengamos con la media de uno de los campos. Esta es una opción 
interesante cuando vas a calcular distintos centros medios según una tipología de los puntos, 
pues incorpora la media del campo señalado para cada centro. Introduce en esta pestaña el 
campo TRAB, de manera que en la tabla de atributos del centro medio te devolverá la media de 
trabajadores para las panaderías. 
 



 
 
Aumenta el tamaño del punto para visualizar mejor el resultado. El centro medio tiene una 
posición bastante centrada en los cinco distritos. Si abres la tabla de atributos verás como la 
capa contiene las coordenadas de ese punto y la media de los trabajadores en las panaderías. 
 

 
 
 
Paso 2: Calculo de la distancia estándar 
 
A continuación vas a calcular una esfera a partir de la distancia estándar tanto a las panaderías 
como a las asesorías jurídicas. Para ello, en el mismo maletín de herramientas vas a utilizar la 
opción Estándar Distance.  
En primer lugar, utiliza la capa de Panaderías.shp. Nombra como DistStandPanaderías a la capa 
de salida, almacenándola en tu directorio de prácticas. Fíjate que puedes trabajar con 1, 2 o 3 
desviaciones estándar. En este caso, vamos a trabajar con 1. Al igual que con el centro medio, 
no vas a usar campo de ponderación y tampoco vamos a usar un campo con distintos tipos de 
panaderías. 

1) 

2) 

3) 

4) 

5) 



 
 

Puedes hacer transparente el resultado y aumentar el tamaño del borde del círculo para 
visualizar mejor el resultado. Si abres la taba de atributos veras como incluye un campo con la 
Distancia estándar. En el caso de las panaderías puedes ver como el radio es muy amplio (más 
de 2 Km), acorde con la fuerte dispersión de las panaderías en el territorio.  

 

 
 
  



Cálculo del centro de gravedad y la elipse de variabilidad 

Habitualmente las medidas estadísticas espaciales son ponderadas en función de la importancia 
de cada uno de los pesos. Por ejemplo, podemos dar más peso a los distintos locales en función 
del número de trabajadores. En este caso, la medida de centralidad será le centro de gravedad, 
y sobre él vamos a obtener las elipses de variabilidad, que nos darán una información más 
completa sobre la variabilidad espacial de los datos incluyendo también direcciones. 

Vamos a comenzar en este caso con las asesorías jurídicas. Antes de calcular el centro de 
gravedad, representa la capa con un mapa de puntos proporcionales en función del tamaño de 
trabajadores con el fin de ver donde se localizan los de mayor tamaño. Para ello, recuerda que 
tienes que ir sobre las > Propiedades de la capa, pestaña de Simbología y aquí elegir un mapa de 
Simbología. Entre los mapas de variables cuantitativas, elije la opción de > Símbolos 
proporcionales. El campo a representar es TRAB. Puedes reducir el tamaño del símbolo menor a 
1 mm para mejorar la representación y elegir como color los azules que veníamos usando 
anteriormente. 

Como puedes ver en el mapa, las asesorías jurídicas de mayor tamaño se localizan en la mitad 
norte, en un eje que tiene dirección norte-sur.  

 

Para calcular el centro de gravedad usamos la opción del centro medio, pero en este caso vamos 
a usar un peso de ponderación, que será este campo de trabajadores (TRAB). Vuelve a la opción 
de centro medio dentro de las Arctoolbox. Como capa de entrada introduce AsesoríaJurídica, a 
la capa de salida llámala CentroPondAsesoríasJurídicas.shp, almacenándola en el directorio de 
prácticas, finalmente en el campo de ponderación (Weight Field) introduce el campo TRAB. 
 



  
Como resultado vas a ver como el centro de gravedad aparece desplazado al norte en relación 
al centro medio, dada la mayor concentración en esta zona de las asesorías de mayor tamaño. 
Cambia la simbología de las dos capas de centro medio y centro medio ponderado para mejorar 
la visualización.  
 

 
 
A continuación vas a calcular el elipsoide de variabilidad, ponderado también en función del 
peso de los trabajadores. Para ello utiliza la opción Directional Distribution (Standard Deviational 
Elipse). Nuevamente, como capa de entrada vamos a usar las asesorías jurídicas. Almacena la 
capa de salida en el directorio de prácticas y llámala ElipseAsesoríasJurídicas.shp, vas a usar 1 
desviación estándar, y nuevamente ponderando por los trabajadores. 
 



 
 
Como verás el resultado es una elipse con dirección norte-sur. 
 

 
 
 

Cálculo del vecino más próximo. 

A continuación, vamos a analizar las pautas de la localización de los locales de actividades en los 
distritos centrales de Madrid, buscando primero conocer si existe una tendencia a la 
concentración o a la dispersión de los mismos. Para ello, en primer lugar vas a usar las técnicas 
de análisis del vecino más próximo, que a partir del cálculo de la distancia entre los diferentes 
pares de puntos compara las distancias existentes con las distancias esperadas bajo una 
situación de completa aleatoriedad. En este caso vamos a trabajar con las localizaciones de las 
Asesorías Jurídicas, que parecen presentar un proceso de concentración en determinados 
espacios del centro de Madrid, y con las farmacias, que por el contrario presentan pautas de 
dispersión. Las dos las vamos a comparar con el modelo de aleatoriedad espacial completa de 
manera que podamos decir si realmente esas pautas de concentración o dispersión son 
significativas o se podrían dar bajo esos supuestos de aleatoriedad. 



Abre una sesión nueva de ArcGis para trabajar sobre un proyecto nuevo. Y añade a la tabla de 
contenidos las capas de Farmacias.shp, AsesoríasJurídicas.shp, Distritoscentro.shp y 
manzanas.shp. Las manzanas te mostraran la localización del espacio edificado, lo que ayuda a 
explicar la localización de los locales. Acomoda las capas y su representación de la manera que 
puedas visualizarlas mejor: 

 

Vamos a calcular mediante el método del vecino más próximo los valores de valor R, que como 
recordarás compara distancia mínima al vecino más próximo en la distribución con la esperada 
para una distribución aleatoria. ArcGIS en lugar de trabajar con una única distancia mínima, 
calcula para cada punto la distancia media a los puntos más cercanos, a partir de un radio de 
búsqueda que fijaremos nosotros. 

Para realizar el cálculo de distancias medias a los vecinos más próximos debes abrir las 
ArcToolbox y abrir las Herramientas de Estadísticas Espaciales (Spatial Statistics Tools), dentro 
de estas ve a las herramientas de Analyzing Patterms. La primera de las opciones que aparece 
(Average Nearest Neighbor) es la que permite realizar el análisis de distancias a los vecinos más 
próximos. 

 

Haz doble clip sobre Average Nearest Neighbor, para calcular los valores R y z sobre la capa de 
farmacias.  



 

El resultado muestra el valor de distancia mínima observada (en el caso de las farmacias es de 
144,03metros) y la esperada (que en este caso sería de 190.42). A pesar de la tendencia de 
dispersión esperada para las farmacias, el valor de R (Nearest Neighbor Ratio) es inferior a 1 
(0,75) lo que muestra una tendencia a la concentración de las farmacias mayor de la esperada 
bajo los supuestos de aleatoriedad completa. Este valor es además significativo, pues el valor Z 
está por debajo del nivel de significación al 95%, que está marcado por los valores de una 
distribución normal, es decir de -1.96 y +1.96. 

 

 
  



Determinar la localización de “hot spots”. 

Una vez analizadas las pautas globales en la localización de los puntos es interesante analizar 
que pasa a nivel local, tratando de ver si existen relaciones entre los puntos más cercanos. Por 
ejemplo, en el caso de las asesorías jurídicas, que acabamos de ver presentan una tendencia a 
la concentración, resulta de interés conocer si existen también agrupaciones de asesorías con 
un número de trabajadores mayor. Es decir, si dentro de esas pautas generales de concentración  
existen agrupaciones espaciales entre las asesorías de mayor tamaño. 

Este tipo de análisis son los que permite el indicador Gi o Getis-Ord, que realiza un cálculo para 
cada punto en función de sus vecinos, de manera que compara el valor de un punto con el de 
sus vecinos, si este es alto y el de sus vecinos también identifica un hot spots.  A la vez, cuando 
el valor del punto es bajo y el de sus vecinos también, identifica un cold spots. Los valores son 
comparados con los que existirían bajo una distribución aleatoria completa, y su valor resultante 
presentado bajo una distribución normal, de manera que cuando el valor que ArcGIS nos da está 
por debajo de -1,96 podemos identificar un cold spots significativo al 95%. Cuando los valores 
son superiores a 1,96 identificamos un hot spots significativo al 95%.  

A continuación vamos a calcular el valor el indicado Gi en el caso de asesorías jurídicas, farmacias 
y restaurantes, a partir del número de trabajadores. Representa cada una de esas capas con un 
mapa de símbolos proporcionales y visualiza las pautas generales de cada una de ellas, te 
ayudará a entender mejor los resultados. 

 
Asesorías

 

Farmacias

 

Restaurantes

 
 

Paso 1: Cálculo del valor Getis-Ord para el conjunto del área de estudio 

Antes de realizar el análisis a nivel de punto, es interesante conocer también si para el conjunto 
de la capa existe una pauta a la localización conjunta de los locales con mayor número de 
trabajadores por un lado y a la localización de los locales con menor número de trabajadores 
por otro.  

Para analizar las pautas de conjunto de las capas de puntos ArcGIS incorpora la opción High/Low 
Clustering (Getis-Ord General G). Esta opción presenta un resultado del valor de Gi observado 
para la distribución de puntos analizada y el valor de Gi esperado con una distribución de puntos 
aleatoria. A partir de estos valores ArcGIS calcula un valor Z. Cuando Z es alto indica la presencia 
de agrupaciones de locales con alto número de empleo por encima de lo esperado con una 



distribución aleatoria. Cuando Z es negativo muestra la presencia de agrupaciones de locales 
con bajo número de empleos. El valor Z presenta una distribución normal de forma que es 
posible señalar la significación estadística de los resultados, cuyos valores de corte para una 
significación al 95% serían de -1,96 y +1,96. Por debajo de -1,96 tendríamos agrupaciones de 
pequeños locales significativamente distintos a lo esperado bajo distribución aleatoria, con 
valores superiores a 1,96 las agrupaciones de grandes locales serían significativas. 

Para calcular el valor de Getis-Ord para el conjunto de una capa de puntos ve a High/Low 
Clustering (Getis-Ord General G), que encontraras en las herramientas de Spatial Statistics Tools 
> Analyzing Patterns. 

Usa primero como capa de entrada las Asesorías Jurídicas. Como campo de entrada utiliza TRAB 
(que contiene el número de trabajadores). Como método de tratamiento de la distancia vamos 
a usar el inverso. En Distance Band podemos introducir un máximo de distancia a considerar 
alrededor de los puntos. Si este radio es muy bajo el análisis es muy restrictivo pues tiene en 
cuenta un menor número de puntos alrededor de los puntos. Pero a la vez, si el radio es muy 
alejado podemos estar incluyendo puntos que tienen poca relación entre ellos. Para fijar estos 
umbrales de relación es interesante analizar el semivariograma (ver módulo 4).  

 

Como puedes ver, el valor de z positivo (1,04) muestra una cierta tendencia a la concentración 
de las asesorías de mayor tamaño. Sin embargo, no podemos decir que, en un radio de 600 
metros, las agrupaciones de asesorías según tamaños tengan significación estadística, pues 
queda por debajo de 1,96.  



 

Paso 2: Cálculo del valor Getis-Ord para cada punto 

A pesar de la no significación estadística a nivel global de la agrupación de asesorías según 
tamaño, pueden existir agrupaciones de carácter local. Para identificar estas agrupaciones 
locales se puede obtener el valor z de Getis-Ord para cada una de las asesorías, de manera que 
nos indique si tratándose de una asesoría un número alto de trabajadores presenta alrededor 
una agrupación de asesorías también con alto número de trabajadores (hot spots) o si por el 
contrario, una pequeña asesoría tiene alrededor también pequeñas asesorías (cold spots). 

Para ello, el valor z es calculado para cada una de las asesorías. Nuevamente su valor está 
normalizado. De esta forma, asesorías con valores positivos indicarán la presencia de hot spots, 
que tendrán significación estadística al 95% cuando estén por encima de 1.96. Los valores 
negativos indican la presencia de cold spots, en este caso con significación estadística por debajo 
de -1.96.  

Para su cálculo, nuevamente en las ArcToolbox, usa las herramientas de estadística espacial 
(Spatial Statistitcal Tools), en este caso en las opciones de > Mapping Clusters la herramienta de 
Hot Spot Analysis (Getis-Ord Gi). Dentro de la ventana de análisis de hot spot, identifica en 
primer lugar 1) la capa sobre la que vas a trabajar1, en este caso AsesoríaJurídica.shp. El campo 
de las asesorías sobre el que vas a trabajar 2) va a ser nuevamente el de número de trabajadores 
(TRAB). El resultado es una nueva capa, idéntica a las asesorías que usas como capa de entrada, 
pero con un atributo nuevo en la tabla, donde se va a incluir los valores individuales del indicador 
z. A esta capa de salida 3), denomínala GIasesorías.shp. 4) El método va a ser de rádio de banda 
fijo, utilizando 5) distancias en línea recta y que vas a establecer 6) en un radio de 600 metros. 
Vamos a usar 7) los trabajadores (TRAB) como valor de autopotencial, de manera que el valor 
de propio punto sea también considerado. 

                                                           
1 Es posible trabajar con capas de líneas y de polígonos, en cuyo caso usaría los centroides de sus figuras.  



 

Existen varios métodos con los que podemos trabajar a la hora de realizar el cálculo del indicador 
GI, que tienen que ver fundamentalmente con el peso que se da al valor de distancia entre los 
puntos. ArcGIS presenta seis posibilidades: 

 

ArcGIS incorpora el resultado a la tabla de contenidos como una capa más. Observa que la capa 
es similar a la capa de asesorías jurídicas, pero al abrir la tabla de atributos encontraras al final 
de la misma un campo con los valores de GiZ600. Los valores van desde valores negativos, 
concentraciones de asesorías con pocos trabajadores a valores positivos, concentraciones de 
asesorías con alto número de trabajadores.  

1) 

2) 

3) 

4) 

5) 

6) 

7) 



 

Si cartografías los resultados puedes identificar fácilmente, por un lado, aquellos puntos entorno 
a los cuales aparecen concentraciones de valores elevados superiores a los esperados con una 
distribución aleatoria completa, con significación estadística para los valores GiZ600 por encima 
de > 1.96, y sin significación estadística para los que estén entre 1,96 y 0. Por otro, 
concentraciones de asesorías de pequeño tamaño: sin significación estadística (valores entre 0 
y -1.96). En este caso, no aparecen concentraciones de pequeñas asesorías que presenten con 
significación estadística (valores por debajo de -1.96). 
 
Los resultados muestran como en la zona norte, en los límites de los distritos de Salamanca y 
Chamberí, aparece una concentración significativa de asesorías de gran tamaño. Que se repite 
en un caso más local en la esquina noreste del propio distrito de Salamanca. 
 

 
  



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Cálculo de caminos mínimos (best route) en ArcGIS 10 

 
Presentación: Se presenta de forma guiada los pasos necesarios para calcular rutas óptimas 
en un Sistema de Información Geográfica (en este caso ArcGIS10). El alumno conocerá las 
distintas opciones con las que trabajar: utilización de barreras, optimización de la secuencia 
de paradas y trabajo con restricciones de tiempos. 
 

Objetivo/s:   

Los objetivos en términos de resultados esperables de la enseñanza son: 

1. Lograr que el alumno sea capaz de calcular rutas óptimas en un Sistema de 
Información Geográfica (SIG). 

2. Capacitar al alumno en el manejo de herramientas para calcular rutas óptimas en 
aplicaciones logísticas, optimizando las secuencias de paradas e introduciendo 
ventanas de tiempos en las paradas. 

 

 
Actividades a realizar: 
Los profesores suministrarán un ejercicio guiado donde se van a calcular rutas optimas de 
viajes siguiendo una secuencia de paradas. Se parte de la localización de seis centros 
comerciales en la ciudad de Alcalá de Henares y se va a crear una ruta óptima para el reparto 
de mercancías en los seis centros. Se va a mostrar al alumno cómo calcular la ruta entre los 
seis centros, cómo se puede optimizar la secuencia de paradas en los mismos y cómo 
introducir ventanas de tiempos para señalar los tiempos de llegada y salida en cada centro y 
los tiempos de carga o descarga del vehículo.  
 

 
Periodo de realización:  3 días 
 

 
Tiempo requerido (estimado profesor):  4 horas 
 

 
Grado de dificultad (estimado profesor): Baja (Tipo A) 
 

 

 

  



VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 

 

  



DESARROLLO DEL EJERCICIO GUIADO POR LOS PROFESORES 
 

1. Camino mínimo entre dos puntos con y sin barreras  
 

La actividad se desarrolla en ArcGIS 10. Previamente se deberán haber descargado las 
capas del campus virtual. Vamos a trabajar con la carpeta > 03Rutas 
 
Abre una sesión de trabajo (.mxd) vacía en ArcMap, para ello haz clic en Inicio, busca > 
ArcGIS > ArcMap. Para abrir una sesión de trabajo en blanco: 
 

 
 
El cálculo de rutas requiere tener activada la extensión de análisis de redes Network 
Analyst, para ello haz clic en el menú Personalizar - Customize > Extensiones: 

 
1. Se abrirá el cuadro de diálogo Extensiones. 
2. Active la casilla de verificación Network Analyst. 

 

 
 
Si no se aparece Network Analyst, será porque la extensión no está instalada. Deberás 
volver a instalar el programa asegurándote instalar la versión completa.  
 
  



En el ejercicio 1 ya has utilizado la herramienta de cálculo de rutas óptimas, en este 
caso vas a aprender a introducir barreras.  
 
Puedes trabajar con la Network Dataset de Alcalá que has creado en el ejercicio 1 o 
usar la que tienes ya creada en el ejercicio 031. Recuerda que para añadir la capa tienes 

que usar el icono . Añade también la capa CentrosComerciales.shp y etiqueta los 
nombres (> botón derecho del ratón sobre la capa centros comerciales > Label 
Features). 
 

 
 
Abre la barra de herramientas de Network Analyst. Recuerda que puedes hacerlo en el 
Menu > Customize > Toolbars: 
 
En Network Analyst selecciona New Route. 

Posteriormente muestra la ventana de Network Analyst  (Paso 1). Activando las 
paradas (Stops) (Paso 2) vamos a introducir dos nuevas paradas, usando el icono de 

añadir localizaciones sobre la red  (Paso 3). La primera parada la vamos a situar 
sobre el centro “HIPERCOR ALCALÁ DE HENARES” y la segunda sobre “LA DEHESA”.  
  

 
 

                                                           
1 Es posible que para usar la red de la carpeta del ejercicio 3 tengas que reconstruirla. Para ello 
es suficiente con añadir la red y en la barra de herramientas de Network Analyst usar el último 

de los iconos:  



Resuelve la ruta  (Paso 1). Verás como el recorrido óptimo se canaliza por la 
Nacional II. Si abres la tabla de atributos de Route (Paso 2) puedes ver que el tiempo 
de viaje es ligeramente inferior a 10 minutos.  
 

 
 
 
A continuación, vamos a poner una barrera puntual sobre uno de los arcos de la 
Nacional II. Para ello, en la ventana de Network Analyst activa Point Barriers (Paso 1), 

usa la herramienta de añadir localizaciones sobre la red  (Paso 2), para incorporar la 
barrera tal como se muestra en la imagen (Paso 3): 
 

 
 
  



Resuelve la ruta. Se introduce un pequeño rodeo para volver a tomar la Nacional II. El 
tiempo ahora es de 11,4 minutos: 
 

 
 
Puedes añadir nuevas barreras puntuales y ver sus efectos sobre la ruta. 
 
A continuación vas a añadir una berrera lineal. Todas las calles atravesadas por la línea 
serán cortadas. Activa para ello Line Barriers en la ventana de Network Analyst y dibuja 
la línea que se muestra en la siguiente imagen, nuevamente con la herramienta de 

añadir localizaciones sobre la red . Resuelve.  
 
Al cortar el paso por la zona norte de la ciudad la ruta atraviesa el centro de la ciudad, 
pero el tiempo se eleva ahora por encima de los 16 minutos: 
 

 
 
  



Finalmente vamos a usar introducir una barrera en forma de polígono, lo que impide 
atravesar la zona delimitada por el mismo. Vamos a cortar el paso por el centro de la 
ciudad. La ruta se desplaza al sur de la ciudad, con un coste ahora de 19 minutos: 
 

 
 

2. Camino mínimo entre varios puntos con y sin orden optimizado 
 
En este ejercicio vamos a realizar una ruta siguiendo una secuencia de paradas. Vamos 
a simular un recorrido de reparto de mercancías por los seis centros comerciales de 
Alcalá. 
 
Quita la pestaña de visible del layer Route y oculta sus capas (Paso 1), después añade 
una nueva ruta con New Route (Paso 2): 
 

 
 
  



Carga los Centros Comerciales como Stops en la ventana de Network Analyst. Para 
ello, con el botón derecho del ratón sobre Stops elige la opción de Load Locations (Paso 
1). Elige la capa CentrosCormerciales.shp. En la propiedad Name elige Nombre. 
 

 
 
 
Como verás, la secuencia de paradas se establece según se ordenan los centros 
comerciales en la tabla de atributos. De esta manera el primer centro, y por tanto la 
primera parada el LA DEHESA, después EL VAL … y el último el centro de 
CUADERNILLOS.  
 

 
 
  



Resuelve la ruta. Puedes ver como la ruta mantiene esa secuencia de paradas abriendo 
la tabla de atributos de la capa Stops. En ella se muestra el orden de la parada (campo 
Sequence) y los minutos acumulados en por la ruta en cada parada (último campo de la 
tabla Cumul Minutos). Como verás, llega a la segunda parada  en poco más de 7 minutos 
y tarda en completar el recorrido 37,5 minutos. 
 

 
 
 
A continuación vamos a ver las opciones que tiene el sistema para optimizar el orden 

de paradas en la ruta. Para ello en las propiedades del análisis de la ruta , ve a la 
pestaña Analysis Settings, marca Reorder stops. Esta opción permite optimizar la 
secuencia de paradas. En una primera opción vamos a mantener la primera y última 
paradas fijas y reordenaremos las intermedias.  
 

 
 
  



La nueva ruta sigue un trazado diferente, optimizando el tiempo recorrido. Ahora la 
segunda parada es el centro LA DEHESA. Puedes comprobar la reducción del tiempo 
en las tablas de la capa de la ruta y de los stops. Veras como el tiempo total de viaje se 
ha reducido a 35,5 minutos 
 

 
 
Optimiza ahora la ruta modificando también el centro de inicio y de final de la ruta. 
Nuevamente en las propiedades del análisis de la ruta, pestaña Analysis Settings, marca 
Reorder stops, y quita las pestañas en Preserve First Stop y Preserve Last Stop (Paso 
2). 
 

 
  



Resuelve la ruta y comprueba los cambios en el mapa y en las tablas. La ruta y la 
secuencia cambian y el tiempo de viaje se reduce a 25 minutos.  
 

 
 

3. Camino mínimo entre varios puntos con restricciones temporales 
 
Finalmente, vamos a trabajar con ventanas de tiempos, de manera que podamos 
establecer tiempos para el inicio de la ruta, para las horas de llegada y salida de los 
centros, y para los tiempos de espera en los mismos (tiempo dedicado por ejemplo a la 
carga o descarga de mercancías. 
 

 
 
  



En Alcalá de Henares existe una regulación de los tiempos de reparto de mercancías 
en la ciudad, de manera que los repartos tienen que realizarse a primera hora de la 
mañana. Los tiempos de reparto varían además según zonas de la ciudad. Se han 
establecido los siguientes horarios para cada uno de los centros: 
 

Centro Hora de 
Entrada 

Hora de 
Salida 

Tiempo 
carga/descarga 

LA DEHESA 9:00 10:00 15 

EL VAL 8:30 9:30 15 

HIPERCOR ALCALA 9:00 10:00 25 

LA DEHESA PARQUE COMERCIAL 9:00 10:00 15 

CARREFOUR ALCALA 8:30 9:30 25 

CUADERNILLOS 8:00 9:00 15 

 
En la tabla anterior se establecen también los tiempos que se dedican en cada centro a 
tareas de carga y descarga, tiempos por tanto que el vehículo deberá permanecer en el 
centro. En los dos centros de mayor tamaño (Carrefour e Hipercor) el tiempo es de 25 
minutos, mientras en los restantes es de 15. 
 
A diferencia del ejercicio anterior ahora vamos a simular que el vehículo de reparto sale 
de un almacén que tiene una localización diferente a los centros comerciales. 
 
Para diferenciar los ejercicios vamos a crear una nueva ruta. En Network Analyst 
selecciona New Route. Quita la pestaña de visible en la ruta anterior: 
 

 
 
  



Añade la capa Almacen.shp, que contiene la localización del almacén de salida de la 
ruta. La capa está en la carpeta > 03Rutas. 
 
En Stops carga como primera parada la localización del almacén. Recuerda, con el 
botón derecho del ratón sobre Stops > Load Locations. En el campo Name carga Central 
y en las horas de inicio y final 8:00 y 8:15. Con ello estamos indicando que el reparto 
debe iniciarse en esa franja de tiempo: 
 

 
 

Usando la herramienta de Load Location carga ahora en Stops las localizaciones de los 
centros comerciales. En Name pon NOMB_CC. 
 

 
 
  



A continuación, sobre cada uno de los centros vamos a introducir los tiempos de llegada, 
salida y carga y descarga que tenemos en la Tabla anterior. En primer lugar tenemos 

que especificar en las propiedades del análisis de la ruta que vamos a trabajar con 
ventanas de tiempos. En las propiedades del análisis de la ruta (Paso 1), ve a la pestaña 
Analysis Settings y marca la opción Use Time Window (Paso 2). Aunque hemos 
establecido ya la hora de salida en el Almacén. En la pestaña Use Start Time puede 
establecerla también (Paso 3). 
 

 
 
Una vez habilitada la opción de ventana de tiempos puedes entrar en las paradas de los 
centros comerciales e introducir los datos. Haz clip con el botón derecho del ratón sobre 
el primero LA DEHESA y ve a propiedades (Paso 1). En TimeWindowStart escribe la 
hora de entrada (en este caso 9:00), en TimeWindowEnd (10:00) y en Attr_Minutos el 
tiempo de carga/Descarga (10:00).  
 

 
 



Haz lo mismo con el resto de centros e introduce los tiempos establecidos para cada 
uno de ellos (Con doble clip sobre cada uno de ellos también accedes a las 
propiedades): 
 

Centro Hora de 
Entrada 

Hora de 
Salida 

Tiempo 
carga/descarga 

LA DEHESA 9:00 10:00 15 

EL VAL 8:30 9:30 15 

HIPERCOR ALCALA 9:00 10:30 25 

LA DEHESA PARQUE COMERCIAL 9:00 10:00 15 

CARREFOUR ALCALA 8:30 9:30 25 

CUADERNILLOS 8:00 9:00 15 

 
Abre la tabla de atributos de Stops y verifica que los datos se han introducido 
correctamente: 
 

 
 

A continuación resuelve la ruta . 
 
  



Como verás, ArcGIS indica que hay centros en los que no puede cumplir con los horarios 
establecidos. Esos centros son los tres últimos, que aparecen marcados con un cuadro 
rojo. Puedes abrir la tabla de Stops y ver los resultados en los tiempos al final de la 
misma. La primera fila indica el tiempo de salida del Almacén (8:00). Posteriormente, 
llega al centro LA DEHESA a las 8:10:38, con lo que tiene que estar esperando 49,36 
minutos a que se abra (Wait_Minutos). A la 5 parada (LA DEHESA PARQUE 
COMERCIAL) llega a las 10:17:19, con un retraso de 17,31 minutos (Violation_Minutes): 
 

 
 
Puedes ver también los tiempos de cada parada en sus propiedades. Como ejemplo 
se muestra a continuación el caso del Hipercor: 
 

 
 
  



Para tratar de optimizar la ruta, podemos por un lado abrir la hora de salida del almacén 
para no obligar a salir a las 8:00 sino que pueda hacerlo entre las 8:00 y las 8:15, y 
después reordenar la secuencia de paradas, fijando únicamente como obligatoria la 
salida en el almacén (primera parada). Entra en las propiedades del análisis y establece 
estas opciones: no marques Use Start Time y pide reordenar las paradas. 
 

 
 

Resuelve ahora la ruta . La hora de salida cambia y también la secuencia de paradas, 
con el fin de cumplir con los horarios y evitar tiempos de espera en los centros. 
Comprueba los resultados. 
 

 
 
 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Creación de una herramienta para el cálculo del reparto 
del flujo de circulación en la red  
 
Presentación: Se presentan de forma guiada los pasos necesarios para crear una herramienta 
en ArcGIS, a través de Model Builder, que permita calcular y representar el reparto del flujo 
de tráfico generado en una red, dado un conjunto de rutas con un peso asignado, o dados 
unos orígenes y unos destinos de viaje, y un peso o una cantidad de viajes asignado a cada 
origen o destino, o dada una simple matriz Origen-Destino, a partir de la cual se calcularían 
las rutas por el camino más corto. En otras palabras, se trata de una herramienta que permite 
conocer cuántos viajes se realizan en cada arco de red, para un conjunto de rutas 
superpuestas con un volumen de tráfico asignado. 
 
Para la realización de la práctica se requieren conocimientos del uso de Network Analyst así 
como conocimientos básicos de Model Builder, así como otros conocimientos sobre 
operaciones básicas como la unión de tablas. 
 

Objetivo/s:   

Los objetivos en términos de resultados esperables de la enseñanza son: 

1. Lograr que el alumno sea capaz de calcular y representar la distribución del volumen 
de tráfico (el número de viajes) por arco de red, dados un conjunto de rutas con un 
volumen de tráfico asignado, o dada una matriz Origen- Destino, a partir de la cual 
se calculan las rutas mencionadas atendiendo al criterio del camino más corto. 

2. Capacitar al alumno en el manejo de Model Builder para crear herramientas 
avanzadas que permitan realizar operaciones nuevas, imposibles de llevar a cabo 
con las herramientas existentes por defecto en las extensiones de ArcGIS. 

 

 
Actividades a realizar: 
Los profesores suministrarán un ejercicio semi-guiado a través del cual generarán una 
herramienta que permita calcular y representar el reparto del flujo de tráfico generado en 
una red nueva. Los estudiantes aplicarán la herramienta a un caso específico, utilizando la red 
de carreteras de Mallorca y sus puntos de población.   
 

 
Periodo de realización:  3 días 
 

 
Tiempo requerido (estimado profesor):  4 horas 
 

 
Grado de dificultad (estimado profesor): Alta (Tipo D) 
 

  



VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 

 

  



DESARROLLO DEL EJERCICIO GUIADO POR LOS PROFESORES 
 

1. Preparación de los datos y generación de las rutas 

Para la realización de la práctica es necesaria la siguiente carpeta de datos: 

 

Donde se pueden encontrar tanto una geodatabase con las capas necesarias para la realización 

del ejercicio como la herramienta Flow Allocation, que nosotros mismos crearemos 

comenzando desde el principio. Es conveniente mantener la estructura de la geodatabase, sus 

diferentes Feature Datasets, para el correcto funcionamiento de la herramienta que 

generaremos. 

En primer lugar, generaremos las rutas correspondientes a los viajes, por el camino más corto, 

de una determinada población situada en uno o varios orígenes, a uno o varios destinos. 

Encontraréis por defecto algunas rutas, que podréis utilizar en la herramienta o sustituir por 

las vuestras propias. Para ello, utilizaremos la red de Mallorca, ya creada, que puede 

encontrarse dentro de la Feature Dataset Network, y tendremos en cuenta sus datos de 

población. Es decir, asumiremos que toda la población de los orígenes viaja a los destinos. (De 

tener datos de flujo real, obviamente estos sustituirían aquellos).  

El siguiente mapa representa la red de carreteras de Mallorca y los puntos de población.  

 

De manera sintética, se recogen los pasos para el cálculo de las rutas. Se supone que los 

alumnos ya tienen estos conocimientos de partida al enfrentarse a esta práctica.  



En primer lugar, seleccionamos como destino la localización de Palma de Mallorca y 

calculamos las rutas del resto de las poblaciones hasta dicha localidad: 

 En la barra de herramientas de Network Analyst, seleccionamos Closest Facility, y 
abrimos la ventana Network Analyst, desde la cual podemos cargar los orígenes y los 
destinos. 

 Definimos el punto de Palma de Mallorac como Facility, y definimos el resto de los 
puntos de la capa Municipios como Incidents. Podemos hacerlos simplemente 
seleccionando unos u otros a la hora de cargar los elementos. 

 En ambos casos, seleccionamos la opción del campo Nombre o Name en las opciones 
de Name, cuando se cargan las capas, de manera que podamos identificar los puntos 
por el valor que tienen en dicho campo (el nombre de la localización).  

 En el cuadro de Closest Facility Properties, definir la impedancia (minutes), y el resto 
de opciones que quisiéramos considerar. 

 Resolvemos el análisis. 

 Exportamos las rutas resultantes (las líneas) como una nueva capa Feature Class 
(recordad que los resultados obtenidos son temporales). Guardamos estas rutas en el 
Feature Dataset InputRoutes, dentro de la geodatabase de trabajo.  

Ahora debemos asignar el flujo de viajes que corresponde a cada ruta. Dado que no tenemos 
el número real de viajeros que viajan de cada población a Palma de Mallorca diariamente, por 
ejemplo, vamos a introducir aquí el dato de población total, simplificando el ejercicio. Para 
ello, simplemente ligaremos los datos de población a los de las rutas, teniendo en cuenta que 
para cada ruta tenemos un campo que nos identifica el punto de origen (incidente). Así pues, 
hacemos una unión de tablas utilizando la herramienta Join Field, por ejemplo, tomando como 
campos de unión el Incident ID y el Object ID.  

El siguiente mapa representa el conjunto de las rutas obtenidas desde cada incidente (cada 
población) hasta Palma de Mallorca (el destino final de cada viaje). 

 

 

 



2. Creación de la herramienta con Model Builder 

 En primer lugar, es conveniente organizar los 
inputs o datos de entrada de acuerdo al 
esquema que representamos aquí.  
 

 La herramienta seleccionará por defecto todas 
las rutas que conducen a estas Feature Datasets.  
 

 Creamos en Catalog una nueva Caja de 
herramientas: Botón derecho / New / Toolbox. 
 

 Una vez creada, la seleccionamos y creamos 
dentro un nuevo modelo: Botón derecho / New / 
Model. Podemos llamarlo Flow Allocation 
 

 Comenzamos a editar el Modelo. Lo 
seleccionamos, botón derecho y Edit.   
 

 Lo primero que hará nuestra herramienta es cortar todas las rutas obtenidas en 
segmentos de red, utilizando como puntos de corte los nodos de la red. Esto nos 
permitirá más adelante saber cuántos segmentos de rutas hay superpuestos sobre 
cada segmento de red, de manera que el número de viajes para cada segmento de red 
será simplemente la suma de todos estos segmentos de ruta considerando el número 
de viajes en cada uno de ellos.  
 

 Para ello introducimos la herramienta Split lines at points y la convertimos en una 
variable desde parámetro (Make a variable from parameter) de manera que, cuando 
utilicemos la herramienta, podamos seleccionar desde su menú tanto los tanto los 
Input features (las líneas que queremos partir, en nuestro caso las rutas) como los 
Point Features (los puntos con los cuales cortaremos las líneas, en nuestro caso los 
nodos de la red).  
 

 Renombramos los inputs del modelo y los llamamos Network nodes and Input route 
lines, de modo que los usuarios lo entiendan mejor.  
 

 Fijamos los inputs como parámetros: Click derecho sobre los globos de entrada, y 
seleccionamos “Model Parameter”  
 

 Podemos dejar las capas establecidas por defecto, según nuestra estructura de datos 
de la geodatabase de trabajo. Para ello: Doble click en el globo de Network nodes  y en 
el de Input route lines y definimos las capas de las rutas y la de los nodos de la red 
 

 Fijamos cierta tolerancia en la aplicación de la herramienta: 10 metros en este caso 
está bien. De esta manera, si las rutas no coincidiesen exactamente con los nodos, se 
cortarían igualmente por estos siempre y cuando su distancia fuera inferior a la 
establecida por la tolerancia.  

 Renombramos el output (globo de salida) como Rutas_Split, y lo fijamos como capa 
“intermediate” output. Esto quiere decir que será una capa intermediaria que sólo se 
utilizará de manera temporal por la herramienta para obtener algo a partir de ella, 
siendo eliminada automáticamente una vez la herramienta se ha ejecutado 



correctamente. Normalmente se almacena temporalmente en la geodatabase que 
tengamos definida por defecto, pero podemos establecer otra ruta.  
 

 La siguiente imagen ilustra esta fase de trabajo en el modelo: 
 

  

 

 El siguiente paso es crear una unión espacial, de manera que podamos unir a cada 
segmento de ruta los atributos del arco de red coincidente. Ahora bien, para ello antes 
vamos a crear un nuevo Network ID en la capa de los arcos de red, que puede 
evitarnos algunos problemas a la hora de hacer la unión espacial. 
 

 Para ello introducimos en el modelo la herramienta Add Field: 
o Click derecho, Make variable / From parameter / Input Table 
o Renombramos el input como Network arcs, por ejemplo. 
o Doble click en Network arcs y selecionamos el la Feature class de las líneas de 

la red RedMallorca por defecto, para que sea el que toma en caso de que no 
introduzcamos nada en el menú.  

o Doble click en Add Field y definimos las otras opciones: el nombre del nuevo 
campo (NetworkArcID) y el tipo de campo (Long).  
 

 Introducimos en el modelo la herramienta Caculate Field: 
o Field Name: NetworkArcID 
o Expression: [OBJECTID] 

 
 

 



 Introducimos ahora la herramienta Spatial Join: 
o Conectamos las Split lines como Target features y Network Arcs como Join 

features. 
o Seleccionamos el campo que queremos unir, simplemente NetworkArcID 
o Seleccionamos la opción  “Have the center in”, como relación espacial, ya que l 

líneas serán coincidentes. 
o Definimos la ruta de salida y un nombre (Rutas_Join), como un parámetro, 

pudiendo definir por defecto el que queramos de salida en cualquier caso.  

 

 Introducimos la herramienta Summary Statistics: 
o Conectamos Split lines como Target feature y Network Arcs como Join 

features. 
o Click derecho sobre el fondo del lienzo del modelo, y hacemos click en la 

opción Create Variable (ver imagen más abajo). Creamos una nueva Variable 
de tipo Field. La llamamos Demand Field, y la fijamos como un parámetro que 
definirá el usuario de la herramienta, para definir cuál es el campo con los 
datos de número de viajes asociado a cada ruta.  

o Ligamos la variable de Demand Field a la herramienta Summary Statistics, 
como Statistics input 

o Doble click sobre la herramienta y definimos el tipo de stadística que vamos a 
calcular (SUM). 

o Doble click en la herramienta y seleccionamos NetworkArcID en la opción Case 
Field  

 



 Introducimos la herramienta Join Field: 
 Seleccionamos NetworkArcID como Input Join Field así como Output Join Field 
 Dejamos el resto de los Join Fields sin marcar, de manera que todos se unirán. 

 

 

 Finalmente, añadimos la herramienta Delete Field y señalamos el campo 
NetworkArcID.  

 Vista del modelo final: 

 

 

 Como resultado final, nuestra herramienta no genera una capa nueva. El resultado 
final se verá en nuestra capa o Feature Class de Network line orginal, cuando 
simbolicemos el nuevo campo en el que se representará el Flujo de Tráfico asignado, 
como se representa a continuación.  
 

 



3. Personalización de la herramienta 

Finalmente, podemos personalizar la herramienta de manera que sea fácilmente utilizable por 
otros usuarios. Para ello: 

 Botón derecho en la herramienta / Ítem description 

 Configuramos las distintas opciones, dando indicaciones en casa paso que ayuden a 
comprender qué hay que introducir en los parámetros, por ejemplo. Ver el siguiente 
ejemplo: 

 

 

4. Asignación de flujos de circulación en redes a partir de puntos Origen y 
Destino.  

Podemos utilizar nuestra herramienta para calcular flujos de circulación en redes a partir de 

matrices origen destino. Para ello, simplemente utilizaremos con anterioridad la herramienta 

Closest Facility para calcular todas las rutas (por el camino más corto) que se derivan de la 

matriz Origen Destino: 

 Seleccionamos la herramienta Closest Facility y abrimos la ventana de Network Analyst 

 Introducimos las mismas localizaciones como puntos de origen y destino (como 
Facilities y como Incidents). 

 A la hora de definir las propiedades del Closest Facility Analysis, fijamos el Máximo 
número de “Facilities to find” como el número total de localizaciones que tengamos, 
de modoe que la herramienta no calculará tan sólo la ruta al Facility más cercano sino 
que calculará todas las rutas a todos los destinos.  

 Resolvemos el análisis y exportamos la rutas creadas. El número de rutas debería ser el 
cuadrado del número total de localizaciones.  

 Si tenemos datos de flujo asociados a nuestra matriz de origen-destino, tendremos 
que unir los campos correspondientes a la tabla de atributos de nuestra capa de rutas. 
Ese será el campo que utilizaremos después como Demand en nuestra herramienta.  

 Finalmente, aplicamos la herramienta creada Flow Allocation que hemos creado. 
 



 

 

 El siguiente mapa muestra el flujo asignado considerando todos los orígenes y destinos 
de Mallorca, y toda su población (a falta de datos reales del flujo entre orígenes y 
destinos).  

 
 
 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Aplicaciones SIG la evaluación de la susceptibilidad a los 
movimientos de ladera: caso de estudio en la cuenca alta del río 
Esla (Embalse de Riaño, León) 
 
Presentación: Para la realización de esta actividad se ofrece una guía que explica todos los 
pasos necesarios para hacer una evaluación de susceptibilidad a los movimientos de ladera 
en un SIG (ArcGis 10.3) mediante la aplicación de un modelo de análisis estadístico 
multivariante. 
 

Objetivo/s:  

 

1. Combinar e integrar datos en un SIG procesados con otro software mediante 
operaciones de captura y depuración. 

2. Integrar y desarrollar modelos sobre problemas espaciales referidos al medio 
natural, donde intervienen múltiples variables. 

3. Valorar las distintas variables que intervienen en el proceso y evaluar las 
consecuencias de las decisiones en la valoración. 

4. Mostrar e interpretar  los resultados obtenidos mediante la generación de 
cartografía específica  

 

 
Actividades: 
El profesor hará una breve introducción sobre los riesgos asociados a los procesos de 
laderas dentro de los riesgos derivados de procesos naturales. Después de definir estos 
riesgos, presentará algunos casos tratados con SIG y los métodos que emplean. 
En el Campus Virtual los estudiantes disponen de un documento en el que se recogen todos 
los pasos necesarios para completar el ejercicio. Se trata de hacer una evaluación de la 
susceptibilidad a los movimientos de ladera en la cuenca alta del río Esla, en el área del 
embalse de Riaño (León) mediante la aplicación de un modelo no determinista basado en el 
análisis estadístico de dos variables (pendiente y resistencia mecánica de la litología).  
  
 

 
Periodo de realización:  :  Entregar en 1 semana 
 

 
Tiempo requerido (estimado profesor):  4 horas 
 

 
Grado de dificultad (estimado profesor): Baja (Tipo A) 
 

 

 

  



VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 

 

  



DESARROLLO DEL EJERCICIO GUIADO POR LOS PROFESORES 
 
 
Material de partida: 
 

Mapa (o capa)  Formato  Fuente (procedencia)  

Mapa Altimétrico  * dgn (MicroStation)  IGN. Escala 1:50.000  

Mapa Hidrografía  * dgn (MicroStation)  IGN. Escala 1:50.000  

Mapa Planimetría  * dgn (MicroStation)  IGN. Escala 1:50.000  

Limite Área de Estudio  * dgn (MicroStation)  IGN. Escala 1:50.000  

Mapa Litológico 
Provincia de León  

* shp (ArcGis)  J.CyL. Síntesis geológica. 
Escala 1:100.000  

 
 

Etapa 1. Preparación de la base topográfica 
 

- La actividad recupera las capas de información topográfica que los estudiantes han 
generado en una actividad de la asignatura obligatoria Cartografía I.  
-En esta primera etapa se depuran los posibles errores altimétricos en MicroStation v8i 
(SELECT Series 3): 
 
A. Cotas. Sustituir el objeto “texto” empleado para representar las cotas, por un objeto 
gráfico de tipo “punto” (proceso manual). 
 

 
 



 
 
B. Curvas de nivel. 

- Buscar errores topológicos (conexión entre las curvas, desde Bentley MAP 
(Topology Cleanup) 
- Encadenar curvas (Groups/Create Complex Chain). 

 

 
 



 
 

 
 
 
 
C.- Asignar la elevación (Z) a las curvas de nivel 
 



- Se utilizará la aplicación (MDL) Civil/Site Tools. (Menu Utilities/MDL Applications). En 
la ventana emergente, seleccionar en Available Applications “CIVTOOLS”, pulsar 
“cargar (load)” 
 

 
 

C.1. Asignar la elevación (Z) a las curvas de nivel: Utilizar la herramienta Set 
Elevation Crossig 

 

 

 
 
 

C.2. Asignar la elevación (Z) a las cotas:  
 
Opción a). Entradas por teclado: Menú Utilities/Key-in  
Introducir la elevación correspondiente a cada cota (objeto gráfico de tipo 
“punto”  
 



 
 
Desde Herramientas “Manipulate (3)” seleccionar “Move”. A continuación 
identificar el elemento que se desea mover. Una vez seleccionado, introducir 
las coordenadas en la barra “Key-in”, y pulsar la tecla “enter” del teclado. 
 
Opción b). Herramienta Civil Tools/Set Element Elevation 
Introducir la elevación correspondiente a cada cota (objeto gráfico de tipo 
“punto”). 

 
 
 

Etapa 2. Preparación del mapa de pendientes 

 
1- Abrir un nuevo proyecto de trabajo vacío en ArcMap. Dar nombre al proyecto y 
establecer las propiedades en Catalog >clic con botón derecho sobre el nombre > 
Propiedades. 

 
 
2- En al ventana emergente, establecer la Geodatabase por defecto y seleccionar 
"Store relative pathnames to data sources". Aplicar y Aceptar. 
 

dl=,,1816  



 
 
3- Activar las extensiones 3D Analyst y Spatial Analyst en el menú Customice 
(Customize > Extensiones) 
 
4- En las Propiedades del Data Frame selecciona el sistema de coordenadas de 
trabajo: WGS 1984 UTM Zone 30N 

-  
 



 
 
 

5- Añadir capas desde el fichero CAD “Prof_Riaño_Altimetria_3D_etrs89_v3”, 
seleccionando (doble clic): 
“Prof_Riaño_Altimetria_3D_etrs89_v3.dgn Point” (contiene las cotas altimétricas) 
“Prof_Riaño_Altimetria_3D_etrs89_v3.dgn Polyline” (contiene las curvas de nivel) 

 
 
 

6- Simbolización (opcional). 
 
Simbolización curvas de nivel: Categories>Unique values>Value Field: Layer 



 
 

7- Añadir límite del área de estudio (Riaño_Limite_Area.dgn (doble clik), y 

seleccionar “Polygon” 

 

 
 
 
 
 
 

7- Crear TIN directamente con los ficheros CAD (*dgn) 

a) Herramienta Create TIN 

 



 
 

 

 



b) Herramienta TIN to Raster (Method: NATURAL_NEIGHBORS and Cell size: 20 

m) 

 
 

 
 

8- Derivar el modelo de pendientes ráster.  

- Utilizar la herramienta Slope en el toolbox 3DAnalyst.  

- Ingresar como capa de entrada el DEM en formato ráster. 

- Dar nombre a la capa de salida 

- Output measurement: DEGREE (deriva las pendientes en grados 

sexagesimales) 



 
 

 
 

9- Valoración de las pendientes del terreno a la susceptibilidad a los movimientos 

de ladera.  

- Existen distintas valoraciones en función del tipo de estudio y de las 

condiciones del territorio que se va a valorar.  

- Se propone utilizar la de Lain et al. (2004) con los siguientes pesos: 

 

Rangos de pendiente, de mayor a menor susceptibilidad Pesos 

Relieve montañoso. Pendiente natural mayor de 60º 5 

Relieve abrupto. Pendiente natural entre 40 a 60º 4 

Relieve ondulado. Pendiente natural entre 20º a 40º 3 

Relieve suave. Pendiente natural entre 10 a 20º 2 

Relieve plano. Pendiente natural menor de 10º 1 

 



Utilizar la herramienta Reclassify en el toolbox 3DAnalyst.  

 
 

 
 
Se propone utilizar la propuesta por el IGME (Ayala y Corominas. 2003) 
 

 
 
 



 
 

 
 

 



- ¿Qué diferencias y similitudes hay entre las dos clasificaciones? 

- ¿Puedes anticipar su influencia en el resultado final del estudio? 

 
Etapa 3. Preparación del mapa de unidades litológicas 

 
1- Desde ArcMap, abrir el fichero geologia100_litologia_h_h24.shp. 
 

 
 
 
2. Recortar el fichero en relación con el límite del área de estudio 
(Riaño_Limite_Area.dgn). 
La base geológica/litológica se corresponde con toda la provincia de León. Se 
realiza un clip, utilizando la capa de CAD, como recorte: Riaño_Limite_Area.dgn 
Polygon 
 

 
 
 



 
 

 
 
 
3. Reclasificar las unidades litológicas según su resistencia mecánica a la 
susceptibilidad a los movimientos de ladera. 
Añadir un nuevo campo (nombre “valor_pesos”, numérico  –short integer-, 
precisión: 3). 
 

 



Valoración de la resistencia de mecánica de las rocas a la susceptibilidad a los 

movimientos de ladera según Lain et al. (2004) 

 

 

 

 
 
 



 
 
 

4- Exportar (o convertir) a ráster, con campo “pesos”. 

- Utilizar la herramienta Polygon to Raster en el toolbox Conversion>To raster.  

- Ingresar como capa de entrada el layer de la litología con sus pesos. 

- En Value_field usar "valor_pesos" 

- Dar nombre a la capa ráster de salida 

- Cell assigment type : CELL_CENTER 

- Priority field: NONE 

- Cell size: 20 m o señalar el mismo tamaño que el fichero de la pendiente. 

 

 



Etapa 4. Preparación del mapa de susceptibilidad a los movimientos de 

laderas 

1- Superposición algebraica del mapa de pendientes reclasificadas y mapa de 
unidades litológicas reclasificadas. 
- Con la herramienta Raster Calculator realizar la superposición algebraica de las 
dos variables seleccionadas con dos operaciones distintas, suma y multiplicación. 
 
2- Reclasificar el mapa de susceptibilidad a los movimientos de ladera 
- Con la herramienta Reclassify establecer distintos rangos cualitativos de 
susceptibilidad de movimiento de laderas. 
 
En el caso de la suma: 

 
 

 



En el caso de la multiplicación: 

 
 

 
 
 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Corrección de modelos digitales de elevaciones con datos 
batimétricos, cálculo de volumen de agua y delimitación de la 
cuenca hidrográfica del Lago de Sanabria (Zamora) 
 
Presentación: Se propone una secuencia metodológica con todos los pasos necesarios para 
la corrección de modelos digitales de elevaciones a partir de datos batimétricos, así como 
para el cálculo de volumen y delimitación automática de una cuenca hidrográfica. La actividad 
integra el manejo de información geográfica tanto en estructura vectorial como raster. 
 

Objetivo/s:   

1. Integrar en un SIG datos vectoriales producidos con software CAD, depurarlos y 
georreferenciarlos. 

2. Capacitar al alumno en la creación de modelos digitales batimétricos mediante 
técnicas de interpolación. 

3. Conseguir que el alumno aprenda a realizar operaciones algebraicas y lógicas con las 
herramientas de análisis espacial. 

4. Calcular volumen a partir de un modelo digital batimétrico. 
5. Capacitar al alumno en el manejo de herramientas de análisis hidrológico para 

delimitar cuencas hidrográficas de modo automático. 
 

 
Actividades a realizar: 
El profesor hará una breve justificación de la necesidad de los datos batimétricos en entornos 
como lagos, lagunas o embalses, y resaltará la utilidad de los mismos. Posteriormente se 
presentarán distintos ejemplos de su utilización en ámbitos profesional (conservación de 
espacios naturales protegidos) e investigador (geomorfología). 
Los alumnos dispondrán de las instrucciones y material necesario para completar el ejercicio. 
La actividad consiste por un lado en la corrección de un modelo digital de elevaciones (hoja 
267 del MTN50) mediante la integración de la batimetría vectorial del Lago de Sanabria 
(Zamora) con el objetivo de obtener la topografía del fondo lacustre; y por otro, delimitar de 
modo automático la cuenca hidrográfica del lago y calcular su volumen volumen de agua. 
  
 

 
Periodo de realización:  2 días 
 

 
Tiempo requerido (estimado profesor):  5 horas 
 

 
Grado de dificultad (estimado profesor): Baja (Tipo A) 
 

 

 

  



VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 

 

  



DESARROLLO DEL EJERCICIO GUIADO POR LOS PROFESORES 
 
 
Material de partida. 
 

Capa 
Localización 

MTN50/25 
Formato 

extensión 
Fuente 

Modelo Digital de 
Elevaciones LIDAR 
5 m 

229, 267 Raster, *asc 

Centro Nacional de 
Información Geográfica,  

Instituto Geográfico 
Nacional 

Curvas batimétricas 
del Lago de 
Sanabria 

267 
Vectorial, 

*dwg 

Parque Natural del Lago de 
Sanabria y Alrededores,  
Junta de Castilla y León 

Mapa Topográfico 
Nacional 1:25.000 

267-I Raster, *ecw 

Centro Nacional de 
Información Geográfica,  

Instituto Geográfico 
Nacional 

 
 

 
 
Modelos Digitales de Elevaciones (LIDAR) de 5 m de resolución (hojas MTN50 229 y 267). 
 

 

 
 

Batimetría oficial del Lago de Sanabria (Zamora). 

 



 

 
 

Mapa Topográfico Nacional a Escala 1:25.000 (hoja MTN25 267-I). 

 
 

1. Preparación del entorno de trabajo.  
 

Abrir un nuevo proyecto de ArcMap, y antes de cargar las capas, definir como sistema 
de coordenadas (Coordinate System) del marco de datos (Data frame): Projected 
Coordinate System → Europe → ETRS89_1989_UTM_Zone_29N. 
 
Asimismo, se crea una (clic en el botón derecho dentro de la carpeta de trabajo → New) 
File Geodatabase en la que se almacenarán los productos derivados de las operaciones 
con las distintas capas, y finalmente se define como geodatabase por defecto en las 
propiedades del proyecto de ArcMap (File → Map Document Properties). 
 
Las operación de análisis posteriores requieren la activación de las extensiones “3D 
Analyst y “Spatial Analyst Tools” (Customize → Extensions...). 
 

 
2. Georreferenciación de la batimetría. 

 
Cargar en ArcMap la capa vectorial de la batimetría (“LAGO SANABRIA.dwg”), pero sólo 
el nivel Polyline y el Mapa Topográfico a escala 1:25.000 (“0267c1-h29.ecw”).  
 

 
 



Como el usuario comprobará la batimetría no tiene ninguna referencia espacial ni 
proyección, por lo que no se superpone con la ubicación del lago. 
 
Para georreferenciarla, en primer lugar se van a exportar (Data → Export data) las líneas 
isóbatas (líneas/curvas de igual profundidad) a la geodatabase creada, previamente 
seleccionadas con la herramienta “Select Features” (no incluir perfiles, líneas rectas).  
 

 
 
En la ventana “Export Data” debe definirse para la nueva capa el mismo sistema de 
coordenadas que en el data frame, definido en el comienzo.  
 

 
 
Para comenzar a georreferenciar, se debe habilitar la edición de la capa de batimetría 
en la barra de edición (Editor → Start Editing), así como la barra de herramientas “Spatial 
Adjustment”:  
 

 



 
La georreferenciación consistirá en la definición de coordenadas para una serie de 
puntos de control establecidos la batimetría. Previamente hay que definir en “Set Adjust 
Data...” la capa a la que afectará el ajuste espacial (georreferenciación), que será la 
capa de batimetría exportada.  
 

 
 
El siguiente paso es identificar en la batimetría y el mapa elementos fácilmente 
reconocibles, como entrantes o salientes agudos: los puntos de control se crean 

mediante la herramienta “New displacement link tool” ( ), y se da clic primero en la 
batimetría y después en el punto equivalente del mapa.  
 

 



 
 
 

 
 
Una vez añadidos los puntos de control (15-20), se elige el método de ajuste que se 
considere más apropiado (por ejemplo, Rubbersheet) y se procede a ajustar (Adjust). El 
resultado obtenido debería ser parecido:  
 



 
 
 

3. Creación del Modelo Digital Batimétrico (MDB) y cálculo de capacidad 
(volumen de agua). 

 
Se pretende crear un modelo raster con la distribución espacial de la profundidad del 
lago, es decir, similar a un MDE, aunque en lugar de altitudes representa profundidades. 
Previamente se deben comprobar en la tabla de atributos las unidades en las que está 
expresada la profundidad, que son decímetros. Para poder hacer posteriormente la 
corrección, las unidades de la batimetría deberán ser las mismas que en el modelo 
digital de elevaciones, es decir, metros.  
 
Esta cuestión se resuelve fácilmente, creando un campo numérico nuevo 
(“Elevation_m”) en la batimetría (Add field), de tipo entero corto (Short integer). A 
continuación, en este nuevo campo se convertirán las unidades de decímetros a metros 
empleando la calculadora de campo (Field calculator; clic con el botón derecho del ratón 
en la cabecera del nuevo campo “Elevation_m”), donde se introduce la siguiente 
expresión: “Elevation / 10”. Ahora las unidades de la batimetría ya están en metros.  
 
Para crear el MDB se utiliza la herramienta "Topo to Raster” (Spatial Analyst Tools → 
Interpolation), en la que se requiere una capa de curvas (isóbatas) y otra con el polígono 
del área a interpolar. Esta segunda capa se crea mediante una simple selección de la 
curva más externa de la batimetría y la ejecución de la herramienta “Feature to Polygon” 
(Data Management Tools → Features), de la que se obtiene un polígono con la 
extensión del lago.  
 



 
 

Ahora ya tenemos una capa que marque el área de interpolación. Introducimos las 
capas en la herramienta y ejecutamos: 
 
 

 
 
Asegurar que el tamaño de celda es 5 m, es decir, el mismo que los MDE LIDAR 5 m 
que se corregirán.  
 
El resultado de la interpolación debería presentar una apariencia similar a esta:  
 



 
 
Si se observaran cambios bruscos en el color del MDB, éstos pueden deberse a valores 
anómalos en las isóbatas, lo que requerirá comprobar y corregir el valor de cota de la/s 
isóbata/s en cuestión (seleccionar líneas y corregir cota con Field calculator) y volver a 
ejecutar la interpolación.  
 
Una vez creado el MDB, es posible calcular el volumen de agua que contiene la cubeta 
del lago, con la herramienta “Surface Volume” (3D Analyst Tools → Functional Surface), 
que calcula a partir del propio MDB el área en 2D y 3D, así como el volumen contenido 
por encima/debajo de un nivel o plano de referencia, que en este caso será 0 (superficie 
del lago):  
 

 
 
El resultado de la aplicación de la herramienta es un fichero *txt en el que se presentan 
los cálculos de área y volumen: 



 
 
Según se puede ver, la capacidad del Lago de Sanabria es de 96.007.203 m3 (96 hm3). 
 
 

4. Corrección del MDE. 
 

Este paso consiste en la eliminación de la lámina de agua del Lago de Sanabria con el 
fin de obtener en su lugar la topografía del fondo. Para ello se utilizará la herramienta 
“Raster Calculator” (Spatial Analyst Tools → Map Algebra). La operación consiste en la 
sustracción del MDB al MDE original de la hoja 267 del MTN (Fichero “MDT05-0267-
H29-LIDAR.asc”). Puesto que el MDB presenta los valores en negativo, se utilizará una 
suma de ambos rasters. 
 
Por defecto, la herramienta hace la operación sólo para los píxeles del área común de 
ambas capas raster (lago), otorgando al resto el valor “No Data”. Para que la corrección 
del MDE sea efectiva y no sólo aparezca el área lacustre, debemos otorgar en el MDB 
el valor “0” a los píxeles con valor “No Data”. Estos píxeles se identifican a través de la 
herramienta “Is Null” (Spatial Analyst Tools → Math → Logical). Antes de ejecutar la 
herramienta, definir en “Environments…” como área de geoprocesamiento (Processing 
Extent) la mismo que la capa “MDT05-0267-H29-LIDAR.asc”.  
 

 
 
El resultado de la aplicación de la herramienta es un raster booleano, es decir, sólo 
contiene dos valores, 0 y 1; los píxeles con valor 1 indican dónde se encuentran los 
valores “No Data” del MDB, mientras que los que muestran 0 señalan dónde no hay 
valores nulos (resultado de la suma en “Raster Calculator”). 
 



 
 
Una vez identificados tales píxeles, se procederá a asignarles el valor 0, dejando el valor 
original de la suma obtenida de “Raster Calculator” en el área lacustre, con la 
herramienta “Con” (Spatial Analyst Tools → Conditional), según se muestra a 
continuación, y definiendo como “Processing Extent” (“Environments…”) el mismo que 
la capa “MDT05-0267-H29-LIDAR.asc”:  
 

 
 
Ahora ya es posible hacer la suma en “Raster Calculator”, introduciendo el nuevo raster 
batimétrico (sin “No Data”) y el MDE (capa “MDT05-0267-H29-LIDAR.asc”):  
 



 
 
El resultado de la corrección del MDE queda del siguiente modo (ver comparativa con 
el original) en sombreado del relieve (Spatial Analyst Tools → Surface → Hillshade):  
 

 
 



 
5. Delimitación automática de la cuenca hidrográfica del Lago. 
 

Una cuenca hidrográfica se define como el lugar geométrico de los puntos que vierten 
a un mismo colector.  En este caso, delimitaremos toda la superficie cuyas aguas de 
escorrentía van a parar al Lago. Es una operación de especial utilidad si decidiéramos 
ubicar determinadas actividades o usos de los que pudieran derivar vertidos o que 
emplearan productos químicos que pudieran llegar al lago y contaminar sus aguas con 
los problemas que ello acarrea (eutrofización, etc.).  
 
La cuenca hidrográfica del Lago es extensa, y ocupa las hojas 229 y 267 del MTN, por 
lo que necesitaremos los MDE de ambas hojas. Para poder delimitar la cuenca al 
completo, se necesita fusionar ambos MDE (mosaico), lo que se resuelve fácilmente 
con la herramienta “Mosaic To New Raster” (Data Management Tools → Raster → 
Raster Dataset). El tipo de píxel, tamaño de celda y número de bandas se consultan en 
las propiedades de los MDE en la tabla de contenidos (clic con el botón derecho del 
ratón en los MDE → Properties → Source). 
 

 



 

 
 
Para la delimitación de la cuenca, se utilizarán las herramientas del módulo “Hydrology” 
de “Spatial Analyst Tools”. Con la siguiente secuencia metodológica: 
 

 
 
En primer lugar, se debe calcular la dirección de flujo de cada celda, es decir la dirección 
en la que descendería la escorrentía. Entonces, se utiliza la herramienta “Flow Direction” 
(Spatial Analyst Tools → Hydrology), en la que se carga el mosaico creado en el paso 
anterior.  
 
El resultado que muestra es un raster de 208 direcciones de flujo. En condiciones 
normales, la herramienta debería producir un raster con la cartografía de las 8 
orientaciones de la rosa de los vientos. Cuando esto no sucede así, como es este caso, 
indica que existen sumideros, es decir, áreas sin drenaje (endorreísmo), que pueden 
ser reales o derivadas del proceso de creación del MDE original. 
 



 
 
Tales áreas de drenaje ineficiente pueden identificarse a través de la herramienta “Sink” 
(Spatial Analyst Tools → Hydrology), en la que se introduce nuevamente el mosaico de 
ambos MDE. 
 

 
 
Para obtener un MDE sin sumideros, se utiliza la herramienta “Fill” (Spatial Analyst Tools 
→ Hydrology), en la que se introduce el mosaico de MDE. El resultado es un MDE en el 
que se han modificado los valores de las celdas calificadas como sumideros de modo 
que no den lugar puntos sin drenaje (han sido “rellenados”). Si ahora se vuelve a utilizar 
la herramienta “Flow Direction”, el resultado es un raster con la distribución espacial de 
8 direcciones de flujo (numeradas de 1 a 128): 
 



 
 
De acuerdo con el esquema planteado inicialmente, el siguiente paso es calcular la 
acumulación de flujo con “Flow Accumulation” (Spatial Analyst Tools → Hydrology), que 
muestra el peso acumulado de las celdas con pendiente descendente de modo que 
muestra la ubicación de los colectores fluviales: 
 

 
 
Para delimitar la cuenca, primero se debe definir el punto de final de la misma, en una 
nueva capa de puntos (clic con el botón derecho en la geodatabase → New → Feature 
Class → Type → Point Features). Atención: la nueva capa de puntos debe tener el 
mismo sistema de referencia que el mosaico de MDE. Una vez creada la capa, con la 
barra de herramientas de edición (Editor), se crea/coloca el punto aguas abajo del 
desagüe natural del lago, en el río Tera, para asegurarnos de que se delimita la totalidad 
de la cuenca incluyendo las áreas que vierten al lago por el Este. El punto tiene que 
estar sobre un píxel de alta acumulación de flujo (píxel blanco o gris claro), ya que de lo 
contrario, no delimitará bien la cuenca. 
 



 
 
El punto de fin de cuenca debe almacenar la elevación del terreno en ese mismo punto, 
lo que se consigue rápidamente con la herramienta “Interpolate Shape” (3D Analyst 
Tools → Functional Surface), donde se introducen el mosaico de MDE (sin sumideros, 
derivado de la herramienta “Fill”) y el punto en cuestión: 
 

 
 
Una vez definido el punto más bajo de la cuenca a delimitar, se utiliza la herramienta 
“Watershed” (Spatial Analyst Tools → Hydrology), donde se introducen el modelo de 
dirección de flujo y el punto más bajo de la cuenca tras incorporarle la elevación en el 
paso anterior. El resultado obtenido es una mancha con la extensión de la cuenca 
delimitada en raster.  
 



  
 
La cuenca delimitada en raster puede convertirse a estructura de datos vectorial para 
hacer cálculos como el perímetro, área, etc. En ese caso, se emplea la herramienta 
“Raster To Polygon” (Conversion Tools → From Raster). 
 

  
 
En la tabla de atributos se pueden observar perímetro (82,5 km) y área (126,1 km2) de 
la cuenca hidrográfica. 
 



 

Anexo 5. Ejemplos de ejercicios semiguiados 

 

  



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Agregación de datos de la tabla de atributos y obtención 
de estadísticas 
 
Presentación: En esta actividad, el alumno deberá generar una nueva tabla de atributos que 
contenga datos agregados obtenidos de otras tablas para poder cartografiarlos 
adecuadamente. 
 

Objetivo/s:   
Adquirir las habilidades necesarias en el manejo de la herramienta “Summary…” a la que se 
puede acceder desde el campo elegido para realizar la agregación en la tabla de atributos. 
Fortalecer las habilidades en el manejo de herramientas de unión de tablas (Join y Relates), 
consultas SQL y de presentación de resultados en mapas temáticos. 
 

 
El ayuntamiento de Madrid ha solicitado saber el número de habitaciones que hay en cada 
barrio de la ciudad y cartografiarlos. La información que se nos ha facilitado contiene una 
tabla con el nombre (NOMBRE), tipo de alojamiento y categoría (TIPO), barrio 
(COD_BARRIO), dirección (DIRECCION), y número de habitaciones (CAPACIDAD) de cada 
hotel por separado, lo que requiere un trabajo de agregación de datos. 

 

Por otro lado, se ha facilitado un shp con el código del barrio (GEOCODIGO) y el nombre del 
barrio (DESBDT). 

 

Además, se solicita conocer cuáles son los barrios con más de 5.000 habitaciones (consulta 
SQL).  

 

Para realizar correctamente la tarea encargada, se deben realizar los siguientes pasos: 

1. Resumir la información de hoteles a barrios, mediante el uso de la herramienta de la 
herramienta “Summary…” a la que se puede acceder desde el campo elegido para 
realizar la agregación en la tabla de atributos, para obtener una nueva tabla con 
tantos registros como barrios de Madrid y en el que se especifique el número total 
de habitaciones (estadística: SUMA). 

2. Unir esta nueva tabla al shapefile de barrios y generar un mapa temático. 

 

Se recuerda que: 

 El campo en el que se aplica la herramienta “Summary…” será el que servirá como 
campo de agregación. Es decir, si hay 5 valores diferentes en ese campo, la tabla 
resultado agregará la información y realizará las estadísticas solicitadas en otros 
campos a sólo 5 registros. 

 El equivalente en el ArcToolBox de la herramienta “Summary…” es “Summarize 
Statistics”. 

 

 



Para realizar el trabajo se dispone de las siguientes capas: 

 Barrios_Mad.shp  

 Alojamiento_MAD.dbf (la información del número de habitaciones no es real) 
 
Fuente original: http://www.madrid.org/nomecalles/DescargaBDTCorte.icm 
 
Se debe entregar un Word explicativo de los pasos generales realizados para realizar las 
consultas (debe aparecer claramente el enunciado de la consulta realizada en todos los casos) 
y otras decisiones que se hayan creído oportunas para poder resolver el problema. 
 
 

 
Periodo de realización:  1 día 
 

 
Tiempo requerido (estimado profesor):  1 hora 
 

 
Grado de dificultad (estimado profesor): Media (Tipo C) 
 

 

  

http://www.madrid.org/nomecalles/DescargaBDTCorte.icm


VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Tabla de atributos: Creación campos, cálculo de campos 
y selecciones por atributos 
 
Presentación: En esta actividad, el alumno deberá enfrentarse al problema de contestar a una 
serie de preguntas que pueden ser contestadas mediante diferentes consultas a realizar en la 
tabla de atributos. Para poder contestar alguna de estas preguntas, se deberá gestionar la 
información facilitada, mediante la creación y cálculo de nuevos campos, por ejemplo. 
 

Objetivo/s:   
Adquirir las habilidades necesarias en el manejo de la tabla de atributos, entendiendo y 
diferenciando el uso de las diferentes herramientas básicas (selección por atributos, 
calculadora de campo…). Se requiere conocer las características de cada tipo de campo. 
 
Se recuerda que la formulación de las consultas en las tablas de atributos de los Feature Class 
puede ser diferente a la de las tablas de atributos de los Shapefiles   
 

 
Se facilita un shp con los siguientes campos: 

 Codigo: código del municipio 

 Texto: nombre del municipio 

 Cod_Prov: código de la provincia 

 Provincia: nombre de la provincia 

 Cod_CCAA: código de la comunidad autónoma 

 ComAutonom: nombre de la comunidad autónoma 

 Pobl_c2011: población del municipio en censo 2011 

 Prov_cap: campo que indica si el municipio es capital provincial o no 

 CCAA_cap: campo que indica si el municipio es capital autonómica o no 
 
Preguntas a contestar (herramientas propuestas para obtener respuesta): 

1. ¿Cuántos municipios tienen más de 100.000 hab.? (Consulta SQL) 

2. ¿Cuántos tienen una población entre 10.000 y 20.000 hab.? (Consulta SQL) 

3. ¿Cuántos tienen una población que no esté comprendida entre 10.000 y 15.000 
hab.? (Consulta SQL) 

4. ¿Cuántas capitales de provincia tienen menos de 100.000 hab.?  (Consulta SQL) 

5. ¿Cuántas ciudades de más de 100.000 hab. no son capital de provincia? (Consulta 
SQL) 

6. ¿Cuántos tienen una densidad mayor a 5.000 hab./km2? (Creación nuevo campo 
que admita decimales + cálculo del valor del campo para cada registro + consulta 
SQL). 

 

Extra: intentad contestar la pregunta 6 sin tener que crear ningún campo nuevo, usando el 
shp original. 

 

 



Se recuerda que: 

 Las consultas SQL se pueden hacer mediante la algebra de Boole (el uso de las 
palabras reservadas AND, OR, NOT) o haciendo selecciones sobre selecciones ya 
realizadas previamente (a definir en consulta por atributos). 

 En la parte inferior de la tabla de atributos se muestra el total de registros y el total 
de registros seleccionados. 

 La calculadora de campo sólo cambiará el valor del campo elegido de los registros 
seleccionados. Si no hay ningún registro seleccionado, entonces se cambian todos 
los valores del campo. 

 
 
Para realizar el trabajo se dispone de las siguientes capas: 

 Municipios_sinCANARIAS_ETRS89_30N.shp 
 
Fuentes originales: 
http://www.arcgis.com/home/item.html?id=2e47bb12686d4b4b9d4c179c75d4eb78 e INE 
 
Se debe entregar un Word explicativo de los pasos generales realizados para realizar las 
consultas (debe aparecer claramente el enunciado de la consulta realizada en todos los casos) 
y otras decisiones que se hayan creído oportunas para poder resolver el problema. 
 

 
Periodo de realización:  1 clase  
 

 
Tiempo requerido (estimado profesor):  30 minutos 
 

 
Grado de dificultad (estimado profesor): Baja (Tipo B) 
 

 

 

  

http://www.arcgis.com/home/item.html?id=2e47bb12686d4b4b9d4c179c75d4eb78


VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Preparación de datos, selecciones y categorizaciones II 

 
Presentación: En esta actividad, se requiere que, a partir de los datos disponibles en el 
shapefile y en una tabla, se cree un nuevo campo en el que se indique la categoría de cada 
ciudad polaca según una serie de criterios. Cartografiar los resultados, mostrando para cada 
categoría un tamaño diferente de punto. 
 

Objetivo/s:   
Adquirir las habilidades necesarias en el tratamiento de datos en la tabla de atributos, 
manejado la selección por atributos y la calculadora de campo. Es necesario el empleo de 
alguna herramienta que permita usar de manera temporal o permanente los datos de otras 
tablas. 
 

 
Para esta práctica se dispone de un shapefile con el código de 31 ciudades polacas (CODE), y 
de una tabla con el código de las ciudades polacas (CITY_COD), el código del voivodato 
(VOI_COD), si es capital de país (C_CAP), si es capital de voivodato (V_CAP) y la población en 
2014 (POP_2014). 
 
Con la información de estas dos bases de datos se requiere clasificar cada ciudad según el 
siguiente criterio (visualización en el mapa resultado): 

1. Cat. 1: Las ciudades que son la capital del País (NUTS0) y ciudades de más de 
1.000.000 hab. (Punto grande). 

2. Cat. 2: Las ciudades que son capital de NUTS2 y ciudades de más de 500.000 hab., 
que no sean Cat. 1 (Punto mediano). 

3. Cat. 3: el resto de ciudades (Punto pequeño). 

 
Para realizar el trabajo se dispone de las siguientes capas: 

 Cities.shp  

 PLpop_2014_2003.xls 
 
Fuentes originales: http://thegpscoordinates.net/ y  http://stat.gov.pl/en/ 
 
Se recuerda que: 

 Las consultas SQL se pueden hacer mediante la algebra de Boole (el uso de las 
palabras reservadas AND, OR, NOT) o haciendo selecciones sobre selecciones ya 
realizadas previamente (a definir en consulta por atributos). 

 En la parte inferior de la tabla de atributos se muestra el total de registros y el total 
de registros seleccionados. 

 La calculadora de campo sólo cambiará el valor del campo elegido de los registros 
seleccionados. Si no hay ningún registro seleccionado, entonces se cambian todos 
los valores del campo. 

 

http://thegpscoordinates.net/
http://stat.gov.pl/en/


Se debe entregar un Word explicativo de los pasos generales realizados para realizar las 
consultas (debe aparecer claramente el enunciado de la consulta realizada en todos los casos) 
y otras decisiones que se hayan creído oportunas para poder resolver el problema. Se 
recomienda el uso de un basemap en la cartografía final. 
 

 
Periodo de realización:  1 clase  
 

 
Tiempo requerido (estimado profesor):  30 minutos 
 

 
Grado de dificultad (estimado profesor): Media (Tipo C) 
 

 

 

  



VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Gestión de diversas tablas de atributos en una única 
tabla de atributos. Join & Relate 
 
Presentación: En esta actividad, el alumno deberá saber realizar uniones temporales entre 
dos o más para poder obtener la información requerida. 
 

Objetivo/s:   
Adquirir las habilidades necesarias en el manejo adecuado de las herramientas Join y Relate 
entre diferentes capas y tablas de atributos. Esta práctica requiere el uso de consultas SQL.  
 
Se deberá conocer el tipo de campo de cada tabla y cuáles de ellos permiten realizar las 
uniones necesarias de manera adecuada. 
 

 
Nos encontramos en un centro de reservas de hoteles y uno de nuestros clientes nos solicita 
el nombre de todos los alojamientos que se encuentran en el barrio de Ríos Rosas, su 
categoría y el número de habitaciones. 

 

La información que se nos ha facilitado contiene una tabla con el nombre (NOMBRE), tipo 
de alojamiento y categoría (TIPO), barrio (COD_BARRIO), dirección (DIRECCION), y número 
de habitaciones (CAPACIDAD) de cada hotel por separado, lo que requiere un trabajo de 
agregación de datos. También se ha facilitado un shp con el código del barrio (GEOCODIGO) 
y el nombre del barrio (DESBDT). 

 

Aunque hay muchas maneras de poder contestar esta pregunta, en este caso se solicita el 
uso de la herramienta “Join” o la herramienta “Relate” para que se pueda contestar a la 
pregunta formulada usando el nombre del barrio (Ríos Rosas) en la consulta que permitiría 
obtener directamente la respuesta solicitada. 

 
Para realizar el trabajo se dispone de las siguientes capas: 

 Barrios_Mad.shp  

 Alojamiento_MAD.dbf (la información del número de habitaciones no es real) 
 
Fuente original: http://www.madrid.org/nomecalles/DescargaBDTCorte.icm 
 
Recordad que: 

 Al realizar cualquier tipo de unión entre tablas, los campos claves de ambas tablas 
deben ser de tipo compatible. Es decir: texto – texto o número – número. 

 
Se debe entregar un Word explicativo de los pasos generales realizados para realizar las 
consultas y otras decisiones que se hayan creído oportunas para poder resolver el problema. 
 

 
Periodo de realización:  1 día 
 

http://www.madrid.org/nomecalles/DescargaBDTCorte.icm


 
Tiempo requerido (estimado profesor):  30 minutos 
 

 
Grado de dificultad (estimado profesor): Media (Tipo C) 
 

  



VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Copia de campos entre capas según uniones espaciales 

 
Presentación: Las bases de datos geolocalizados permiten trabajar con la componente 
espacial de los datos. Esto permite poder copiar campos de una capa a otra según sea su 
relación espacial y según algún criterio de unión (que hacer con las entidades de una capa que 
cumplen con un criterio de localización con más una entidad de la otra capa) 
 

Objetivo/s:   
Adquirir las habilidades necesarias la copia de campos de una capa a otra según la relación 
espacial. Definir adecuadamente que ocurre cuando un elemento de una capa cumple las 
condiciones de unión con más de un elemento de la otra capa. Este ejercicio también permite 
repasar conceptos de selección por atributos, creación de campos, cálculo de campos y las 
herramientas de agregación y obtención de estadísticas varías. 
 

 
Para esta práctica se disponen de dos shp. En el shp “roads_2012” se encuentra los siguientes 
campos: 

 “Shape_Leng” que indica la longitud de cada tramo de carretera en metros,  

 “ID” que indica el número de tramo, 

  “Category” que indica a que categoría pertenece cada tramo.  
 
Los campos del shp “EU_country_ETRS89_LCC_EUROSTAT_2012” son: 

 “OBJECTID” que indica el identificador numérico de cada país 

 “CNTR_ID” que indica el código de cada país 

 “Highway_sp” que indica la velocidad tipo en km/h de las carreteras “Highways” 

 “MainRoad_sp” que indica la velocidad tipo en km/h de las carreteras “Main Roads” 

 “SecRoad_sp” que indica la velocidad tipo en km/h de las carreteras “Secondary 
Roads” 

 “EU” que indica si el país es de la Unión Europea (2015) o no 
 

Se solicita transferir la información del shp EU_country_ETRS89_LCC_EUROSTAT_2012” 
al shp “roads_2012” de manera adecuada y cumpliendo con los siguientes criterios: 

 Cada tramo de carreteras solo debe tener un tipo de velocidad, según país y 
categoría 

 No se puede dividir ningún tramo de carretera, en caso de que algún tramo caiga 
entre dos países, la velocidad de dicho tramo corresponderá a la inferior. 

 

También se solicita: 

 Obtener el tipo de viaje en minutos por cada tramo de carretera. Observar que 
mientras la velocidad ha sido proporcionada en km/h, la longitud de cada tramo 
esta proporcionada en metros. 

 Obtener la estadística del número de km de cada tipo de carretera por país 
(Summarize Statitistics) 



 
Para realizar el trabajo se dispone de las siguientes capas: 

 roads_2012.shp  

 EU_country_ETRS89_LCC_EUROSTAT_2012.shp 
 
Fuentes originales: http://www.regroningen.nl/stelder/ y 
https://en.wikipedia.org/wiki/Speed_limits_by_country 
 
Se debe entregar un Word explicativo de los pasos generales realizados para realizar la copia 
de datos entre una capa y otra. Se debe hacer un zoom a un tramo de carretera que 
pertenezca a dos países y comprobar que la velocidad de dicho tramo corresponde a la menor 
de las velocidades. Se requiere adjuntar la tabla de resultados con los km de red para los tres 
tipos de vías para Alemania, España, Francia, Italia y Reino Unido. 
 
 

 
Periodo de realización:  7 días. 
 

 
Tiempo requerido (estimado profesor):  1 hora. 
 

 
Grado de dificultad (estimado profesor): Alta (Tipo D) 
 

 

  

http://www.regroningen.nl/stelder/
https://en.wikipedia.org/wiki/Speed_limits_by_country


VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: De “Excel” a datos espaciales. Proyecciones y 
reproyecciones 
 
Presentación: En esta actividad, se presenta un caso en el que se han tomado las coordenadas 
GPS de varios puntos y están guardadas en una tabla. Esta información debe ser representada 
en un mapa de manera automática. Por otro lado, por cuestiones del estudio, se considera 
que los datos finales deben estar en sistema de coordenadas llamado Lambert Azimuthal 
Equal Area (LAEA) o EPSG:3035. 
 

Objetivo/s:   
Entender el uso de las herramientas de transformación de coordenadas a elementos 
vectoriales (Make XY Events). Tener en consideración las cuestiones de sistema de 
coordenadas con el que se han recogido los datos y con cual se debe trabajar. Posible uso de 
la herramienta “Project”. 
 

 
La tabla adjuntada tiene los campos, CODE que hace referencia al código de la ciudad, LAT 
que hace referencia a la coordenada latitud obtenida por GPS, y LON que hace referencia a 
la coordenada longitud obtenida por GPS. 

 

Los pasos a seguir son: 

1. Añadir la hoja Excel correspondiente, la que contiene los datos 

2. Utilizar la herramienta que convierte los datos de una tabla en puntos. Identificar y 
especificar adecuadamente la columna de cada coordenada y el sistema de 
coordenadas de coordenadas. 

3. Realizar la reproyección adecuada, si se considera necesario. 

 

Se recuerda que: 

 Se pueden abrir archivos de Excel en ArcGIS, pero se debe definir cuál es la hoja que 
se quiere introducir en la tabla de contenidos. 

 Las coordenadas de GPS son de la familia de las coordenadas geográficas que usan 
el datum WGS 84 (EPSG:4326) 

 
Para realizar el trabajo se dispone de las siguientes capas: 

 Points.xlsx 
 

Fuente original: http://thegpscoordinates.net/ 
 
Se debe entregar un Word explicativo de los pasos generales realizados y la captura de imagen 
de la distribución de los puntos. Se aconseja usar un basemap para entender qué tipo de 
puntos son y comprobar que se ha realizado correctamente el ejercicio. 
 
 
 



 
 
 
 

 
Periodo de realización:  1 clase  
 

 
Tiempo requerido (estimado profesor):  15 minutos 
 

 
Grado de dificultad (estimado profesor): Baja (Tipo B) 
 

 

 

  



VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Búsqueda de un emplazamiento óptimo para la 
construcción de un camping en un espacio natural 
 
Presentación: Se trata de utilizar un Sistemas de Información Geográfica Raster y sus 
herrmanietas de consulta, reclasificación y análisis de superficie para encontrar la localización 
de un espacio que cumpla con una serie de criterios.  
 
Se trata de un trabajo práctico que puede realizar el alumno a mediados del curso, una vez se 
han visto en clase las herramientas a utilizar. Debe permitir consolidar lo aprendido en clase. 
 

Objetivo/s:   
Determinar la aptitud del terreno para localizar un camping en Sanabria.  
 

 
Actividades a realizar: 
 
Se obtendrá una capa raster donde cada celda tenga una valoración de 0 a 10. Para ello se 
van a considerar y valorar 5 criterios, y se obtendrá una media para cada celda de esas 
valoraciones. Los criterios a considerar son: 

 Pendiente: La mayor aptitud se da en las zonas llanas. En zonas de pendiente superior 
a 10% no es posible ubicar el camping. 

 Orientaciones: Las mejores orientaciones son las solanas (Sur) 

 Distancia a ríos: La mejor localización en próxima a un río 

 Altitud: que la altitud sea baja. En cualquier caso inferior a 1200 metros 

 Vegetación: las unidades óptimas son (por este orden): erial-pastizal; zonas de monte 
bajo; praderas naturales; pino silvestre; y pináceas no aterrazadas 

 
Pasos a seguir 

1. Añade las capas que necesitas para el trabajo (directorio 
0CapasSIGII\Raster\Sanabria).  

2. Define las unidades métricas del Data Frame  
3. En las ArcToolBox define en Environments las condiciones para el análisis 
4. Carga el MDT y calcula pendientes en % desde 

ArcTools/SpatialAnalysisTools/Surface/Slope 
5. Genera una capa donde se valoren las pendientes de 0 a 10. Usando la función de 

reclass, y dando los  valores de: 

 10 (máxima aptitud) a las pendientes llanas (de 0);   

 9 a pendientes de 0,01 a 1;  

 8 a pendientes de 1 a 2; 

 …;  

 las pendientes superiores a 10% serán “NoData”. 
6. Calcula las orientaciones desde ArcTools/SpatialAnalysisTools/Surface/Aspect 
7. Genera una capa donde se valoren las orientaciones de 0 a 10. Usando la función de 

reclass, y dando los valores de  

 10 (máxima aptitud) a las orientaciones Sur (de 157.5-202.5º);   

 valor 9 a orientaciones SW (157.5-202.5);  



 valor 8 orientaciones SE (112.5-157.5);  

 7 a orientaciones llanas (-1);  

 4 a orientaciones W;  

 3 a las orientaciones E;  

 2 a las orientaciones NW;  

 1 a las orientaciones NE;  

 0 orientaciones Norte. 
8. Calcula distancia a los ríos desde desde 

ArcTools/SpatialAnalysisTools/Distance/EuclideanDistance 
9. Genera una capa 0 a 10 reclasificando con intervalos iguales las distancias, siendo 10 

el intervalo más cercano y 0 el más lejano. 
10. De la misma forma, genera una capa 0 a 10 reclasificando con intervalos iguales las 

alturas (mdt) de 850 a 1200 metros, siendo 10 el intervalo de alturas más bajo y 0 el 
más alto. Alturas superiores a 1200 metros serán “NoData”. 

11. Valora las unidades de vegetación, siendo: 

 10 las zonas de erial-pastizal;  

 8 las zonas de monte bajo;  

 6 las praderas naturales;  

 4 el pino silvestre;  

 2 las pináceas no aterrazadas 

 En el resto de usos no se puede localizar… Serán “NoData”  
12. Calcula la media de las valoraciones para cada celda en los 5 criterios, usando 

ArcTools/SpatialAnalysisTools/Local/Cell Statistics 
13. Calcula la desviación típica de las valoraciones para cada celda en los 5 criterios, 

usando ArcTools/SpatialAnalysisTools/Local/Cell Statistics 
14. Haz una composición de mapa para presentar los resultados de los dos mapas 
15. Realiza una mínima interpretación de los resultados (1 párrafo) 

 
Escribe la práctica en Word indicando los pasos que das y mostrando los resultados 
parciales en pantallazos y el final como composición de mapa. Sube al Campus Virtual.  
 

 
Periodo de realización:  Entregar en 1 semana 
 

 
Tiempo requerido (estimado profesor):  4 horas 
 

 
Grado de dificultad (estimado profesor): Media (Tipo C) 
 

 

 

  



VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Cuantificación de variaciones morfológicas. Caso 
práctico: seguimiento de las variaciones en glaciares cubiertos y 
en glaciares rocosos 
 
Presentación: Se plantea un ejercicio para conocer si hay movimiento superficial en un 
glaciar cubierto de escombros partiendo de imágenes aéreas  e información topográfica de 
detalle y utilizando un SIG.  
 
En este ejercicio el estudiante deberá aplicar una secuencia de herramientas conocidas y 
otras nuevas para responder a un problema real perteneciente a un proyecto de 
seguimiento de glaciares. 
 

Objetivo/s:   
- Aprender a manejar información de partida elaborada por otro grupo de trabajo. Utilizar y 
convertir ficheros de intercambio. 
- Aplicar un flujo de trabajo semiguiado y comprender/interpretar las acciones del mismo 
con su vocabulario específico. 
- Seleccionar y extraer la información necesaria en las tablas de atributos. Realizar cálculos 
espaciales en las tablas de atributos. 
- Representar de forma efectiva los resultados (mapas de vectores de movimiento, 
cartografías de interpolación de resultados y diferencias temporales).  
- Comparar superficies en 3D. Cuantificar las variaciones de espesor y volumen en 3D. 
- Extracción de estadísticas básicas sobre los resultados cartográficos en 2D y en 3D. 
 

 
Actividades: 
 
El ejercicio tiene como objetivo conocer si existe movimiento superficial en un glaciar 
cubierto de derrubios, dónde se produce este movimiento, medir el movimiento y 
cuantificar las variaciones en 3D (espesor y volumen), además de extraer las estadísticas 
básicas de los resultados 
 Se obtendrá una capa raster donde cada celda tenga una valoración de 0 a 10. Para ello se 
van a considerar y valorar 5 criterios, y se obtendrá una media para cada celda de esas 
valoraciones. Los criterios a considerar son: 

 Medidas de movimiento superficial -horizontal y vertical- de bloques. 

 Creación de mapas derivados (flujos, velocidad, tasas anuales…). 

 Cuantificación de las variaciones morfológicas en 3D (espesor y volumen). 
Representación gráfica. 

 Extracción de estadísticas básicas por unidades geomorfológicas. 
 
Material de partida: 

 Topografía: Topo_Holadalsjokull_Update_1980.dgn y 
Topo_Holadalsjokull_Update_1994.dgn. 

 Unidades geomorfológicas: units_holar.shp 

 Ortofotos de apoyo: Holar_Zona1_1980.jpg; Holar_Zona1_1994.jpg ; 
Holadalur_Ortofoto_2000.jpg 



 Bloques localizados en la superficie del glaciar: Blocks_Holar_1980.dgn and 
Blocks_Holar_1994.dgn. 

 
 
Pasos del ejercicio: 
 
-Antes de comenzar la actividad hay que descargar los ficheros del ejercicio del Campus 
Virtual. 
-Se hará una breve explicación del tratamiento topográfico de la información de partida y de 
su resolución temporal y espacial.  
 

1. Abrir un proyecto de trabajo nuevo (.mxd) y crear una Geodatabase de trabajo. 
(Como se trata de una asignatura avanzada, los estudiantes ya conocen los  pasos de 
preparación del espacio de trabajo y deben de realizarlos sin guía). Asegurarse de 
que estén cargadas las Extensiones 3D Analyst y Spatial Analyst.  el sistema de 
coordenadas de trabajo es "Lambert_Conformal_Conic_2SP". 

2. . Una vez preparada la información topográfica en el CAD, convertir los ficheros 
*dgn a *shp, etiquetando los bloques (revisar textos duplicados). 

3. Obtener la “x,y” de cada punto (bloque). Desde la tabla de datos, crear campo para 
la X y para la Y, y, a continuación, calcular geometría. 

4. Obtener la distancia entre los bloques entre ambas fechas (1980-1994) 
a. Join tables  
b. Export table (p.e. Table_1980_1994.dbf) 
c. Vector de desplazamiento entre cada bloque. Data Management 

Tools/Features/ XY to Line.  
d. Crear campo en la tabla “distance”, y calcular geometría 
e. Crear campo “m_year”, y calcular velocidad año (Distance/14 años)  

5. Paso 4. Distribución espacial de los desplazamientos. Crear “centroide” de cada 
vector (Features to point), y representar el resultado utilizando el campo (m_year) 

6. . Obtener el mapa del movimiento horizontal mediante un proceso de interpolación. 
a. Menu Selection/Select by location (si se quiere definir el área con los 

bloques que se interpolarán). 
b. Interpolación. Spatial Analyst Tools/Interpolation/Kriging  

7. Calcular el movimiento vertical del glaciar cubierto de derrubios (diferencias de 
altitud entre 1994-1980) y obtención de la cartografía correspondiente: 

a. Join Table Atributtes. Join “Table_blocks_1994” a la “Table_Block _1980”  
b.  Exportar tabla “Table_Elevation_1994-1980” 
c.  Abrir nuevo campo “DoD_94-80 y calcular geometría (diferencias de 

elevación) 
d.  Join “Table_Elevation_1994-1980” a la capa Holar_Blocks_1994 
e.  Interpolar sobre campo “DoD_94-85” (kriging) 

8. Extracción de estadísticas básicas por unidades geomorfológicas 
a. Menu Geoprocessing/Intersect. Intersección de las capas 

“Holar_Centroides_1980-1994 y Holar_Units” 
b. Select By Attributes (campos m_year y DoD_1994-1980) 
c. Mostrar estadísticas y recopilarlas en una tabla 



 
 

9. Cuantificación de las variaciones morfológicas en 3D (espesor y volumen): 
a. Creación de los modelos de elevación para las dos fechas a partir de los 

datos vectoriales.(Dos posibilidades TIN-TIN to Raster o Topo to raster) 
b. Comparación de superficies 3D (Raster calculator). 
c. Reclasificación de los resultados en valores negativos (pérdida de espesor), 

en torno a o (sin cambios) y positivos (aumento de espesor). 
d. Extracción de las estadísticas zonales (Zonal-Zonal Statistics as Table). 

Interpretación de los resutlados y presetnación del mapa final. 
e. Como alternativa al proceso anterior utilizar la herramienta Cut/Fill. 
f. Operar en la tabla de atributos para calcular la diferencia de espesor medio  

(positivo y negativo) en las distintas unidades y calcular los volúmenes de 
aumento y de disminución. Presentación cartogáfica. 

 
 

 
Periodo de realización:  Entregar en 1 semana 
 

 
Tiempo requerido (estimado profesor):  4 horas 
 

 
Grado de dificultad (estimado profesor): Media (Tipo C) 
 

 

 

  



VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



 

Anexo 6. Ejemplos de ejercicios autónomos 

 

 

 

  



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Evaluación de la accesibilidad de la población a la red de 
Metro de Madrid. 
 
Presentación: Se trata de evaluar la accesibilidad de la población a la red de Metro de Madrid 
en un barrio (elegido por el alumno), comparando dos situaciones temporales. Antes y 
después de la apertura de nuevas estaciones (una o más, con sus correspondientes bocas de 
metro). Se puede plantear como un análisis ex-ante (¿Qué pasaría si se abriera una nueva 
estación en…?) o ex-post (¿Cuál ha sido el efecto de la apertura de una nueva estación en…?). 
Se pueden plantear hipotéticamente distintos escenarios: quitar una estación de las 
existentes (como si no existiera hace x años), localizar una nueva estación entre dos 
estaciones de la misma línea, proponer una nueva línea con varias estaciones, etc. 
Simplemente hay que explicitar esos planteamientos hipotéticos.  
 
Se trata de un trabajo fin de asignatura. Se pretende que el trabajo sea abierto, no dirigido, 
simulando la situación real en el mundo de la empresa o la universidad, donde se plantean 
problemas, pero el técnico o investigador debe dar los pasos necesarios para resolverlos. 
 

Objetivo/s:   
Poner en práctica los conocimientos sobre el uso de herramientas SIG vectoriales. El alumno 
debe indagar sobre cómo utilizar las herramientas que conoce al final de la asignatura para la 
resolución del problema planteado. 
 

 
Actividades a realizar: 

 Como mínimo el alumno debe calcular la cantidad de población cubierta por la franja 
de cobertura de 300 metros en torno a las bocas de metro, mostrando los datos 
desagregados según estaciones.   

 Se deben considerar las estaciones del propio barrio y también aquellas de barrios 
vecinos cuya cobertura se extiende por el territorio del propio barrio.  

 El análisis de población cubierta debe realizarse al menos por el método la 
ponderación areal (areal weighting): en los polígonos parcialmente incluidos en el 
área de cobertura, la proporción del polígono que queda dentro del área de cobertura 
determina la proporción de población del polígono cubierta.  

 Se consideran dos situaciones temporales, para evaluar los beneficios de la apertura 
de una o varias estaciones. Para ello es necesario actualizar la capa de usos y 
población, para contemplar los nuevos desarrollos urbanísticos, lo que implica 
realizar tareas de digitalización y edición. 
 

Adicionalmente el trabajo puede ampliarse con más cuestiones, como por ejemplo: 

 Calcular la población cubierta comparando los resultados obtenidos con dos formas 
de referenciar la población: polígonos (ponderación areal) y centroides de polígonos 
(obtenidos de los polígonos)  

 Considerar distintas franjas de cobertura en vez de una sola, por ejemplo 300, 600, 
900 metros, indicativas de distintos niveles de calidad de acceso al Metro. Calcular 
lo anterior para cada una de las estaciones. 



 Calcular la distancia media (ponderada y sin ponderar) de la población a las bocas de 
Metro para el barrio en conjunto y según estaciones.  

 Calcular la cantidad de empleo cubierto (además de la población) 

 Calcular distancias desde farmacias, bares-restaurantes, etc. hasta estaciones de 
Metro 

 Etc. 
 
Para realizar el trabajo se dispone de las siguientes capas: 

 bocasMetro.shp (bocas de Metro) 

 madrid_usos.shp (población en 2000, uso en 2000 y uso futuro) 

 barrios.shp (barrios de Madrid) 

 -capas de farmacias, bares-restaurantes, asesoría jurídica (con dato del número de 
trabajadores en el campo TRAB). Se asume que estas capas contienen el total de 
empleos. 

 
El trabajo se entrega en un documento en Word por el Campus Virtual. El documento debe 
ser explicativo del trabajo realizado: objetivos, metodología, resultados. Debe incluir 
imágenes (obtenidas de ArcMap) y tablas. Se aconseja incluir un diagrama de flujo. 
 

 
Periodo de realización:  2 semanas  
 

 
Tiempo requerido (estimado profesor):  50 horas 
 

 
Grado de dificultad (estimado profesor): Media (Tipo D) 
Ejercicio Autónomo   
 

 

 

  



VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Asignación de servicios y rutas de flotas.  

 
Presentación: Se trata de un ejercicio autónomo donde el alumno deber utilizar herramientas 
de análisis de redes para resolver un problema de asignación de demanda a servicios 
educativos y cálculo de rutas para una flota de vehículos. En este caso aplicado a la gestión 
de servicios educativos y rutas escolares. 
 

Objetivo/s:   

Los objetivos en términos de resultados esperables de la enseñanza son: 

1. Usar herramientas de asignación de demanda a servicios en función de la 
proximidad 

2. Lograr que el alumno sea capaz de calcular rutas óptimas para una flota de vhículos 
en un Sistema de Información Geográfica (SIG). 

3. Capacitar al alumno en el manejo de herramientas para calcular rutas óptimas en 
aplicaciones logísticas. 

 

 
Actividades a realizar: 
 
Utilizando capas de la Isla de Mallorca los estudiantes deben realizar las siguientes 
actividades: 
 

1. Asignar los escolares a las localidades con Instituto por proximidad (Closest Facility). 

2. Para Inca, usando los escolares asignados, calcular tres rutas de autobuses.   

a. Tiempo de parada del autobús para recoger a los estudiantes 0,5 minutos; 

Pickup Quantities  “estudiantes”;  

b. Depots: Garaje (usando Inca y sin tiempo) e Instituto (usando Inca con 

tiempo de llegada de 08:45 a 08:55);  

c. Rutas: 3 Salida Garaje, llegada Instituto, hora de salida “Earliest: 7:00” 

“Latest: 9:00”; Capacities: 60; máximo de paradas 30; tiempo máximo: 80 

Minutos  

3. Localizar dos nuevos institutos en la isla, siendo los candidatos las localidades sin 

instituto 

 

 
Periodo de realización:  3 días 
 

 
Tiempo requerido (estimado profesor):  4 horas 
 

 
Grado de dificultad (estimado profesor): Alta (Tipo F) 
 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Estudio de peligrosidad en un proyecto de evaluación de 
riesgos naturales en el entorno del río Alfambra a su paso por la 
población de Villalba Baja (Teruel). 
 
Presentación: Se plantea un caso real en el que se encarga a una consultora medioambiental 
un proyecto de estudio de riesgos. La dirección de la Consultora reparte el trabajo en equipos 
y encomienda tres estudios parciales de peligrosidad a uno de los equipos, con la condición 
imprescindible de que las capas de información y los resultados generados sean compartidos 
por todos los equipos (ya que deberán completar el trabajo con la máxima eficiencia). El 
estudiante deberá elegir dos de los tres estudios parciales y desarrollarlos según las premisas 
propuestas y la información disponible. Tendrá que presentar un informe en el que se señalen 
los objetivos, se liste la información de partida, se desarrolle un flujo de trabajo y se presente 
una cartografía técnica final. Deberá incluir las salidas gráficas en formato *.kmz y el proyecto 
de trabajo para compartir en formato*.mpk. 
 
Este ejercicio se propone como parte del examen final de la asignatura y plantea un trabajo 
no dirigido que simula una situación real en la empresa. Deberá dar los pasos necesarios para 
alcanzar el objetivo propuesto, tomar opciones en el proceso (siendo conscientes de cómo 
influyen en el resultado final)  y presentar de diferentes formas los resultados. 
 

Objetivo/s:   
Aplicar las destrezas adquiridas sobre el empleo de herramientas SIG (vectoriales y ráster). 
Integrar y desarrollar modelos multivariables sobre problemas espaciales referidos al medio 
natural. Mostrar los resultados en una cartografía específica técnica y en una salida gráfica de 
divulgación. Compartir la información y expresar los procesos en un lenguaje común en un 
equipo de trabajo.  

 
Actividades: 

 Se pide emitir los informes, acompañados por los archivos utilizados y generados, 
correspondientes a dos de los siguientes subproyectos: 

A. Proyecto de susceptibilidad de movimiento de laderas. El área de estudio queda 
delimitado en el archivo "study_area.shp" y la cartografía final se presenta a 
escala 1:25.000. 

B. Proyecto de disponibilidad de masa vegetal para calcular el índice de 
combustibilidad. Se deberá presentar una cartografía de altura y densidad de la 
vegetación, con una resolución de 5x5 m, del área comprendida entre las 
coordenadas (Xmín=662.000; Ymín=4.472.000; Xmáx= 666.000; 
Ymáx=4.480.000). 

C. Proyecto para generar varios escenarios de inundación suponiendo que el río 
incremente su altura en 1, 2 y 5 m. El resultado se expresará con una resolución 
de 5x5 m, en el área comprendida entre las coordenadas (Xmín= 662.000; 
Ymín=4.472.000; Xmáx= 666.000; Ymáx=4.480.000). 

 El estudiante deberá obtener los ficheros digitales LiDAR a través del Centro de 
Descargas del IGN 



 En el caso A, se deberán tomar decisiones para establecer rangos peligrosidad por 
pendiente y por características litológicas. También se tendrá que elegir la operación 
ráster para integrar toda la información, así como la clasificación final. 

 En el caso B, se deberá depurar la información y seleccionar solo la que cumpla 
determinados criterios para la creación de los modelos apropiados. La selección de 
intervalos para la presentación final se hará aplicando los criterios adecuados. 

 En el caso C, se deberá elegir la generación de un MDT apropiado para el objetivo del 
trabajo. El criterio del estudiante es un factor determinante en el trazado de los 
perfiles transversales para las simulaciones. La presentación adecuada es 
indispensable para la interpretación de los diferentes escenarios.  

 En todos los casos, se deberá presentar un informe sintético y preciso, con la salida 
cartográfica técnica apropiada. La creación del .mpk y el flujo de trabajo servirán para 
transmitir la información entre los distintos grupos de trabajo de la empresa. Las 
salidas .kmz facilitarán la visualización rápida en cualquier ordenador. 
 

Además , el trabajo se puede ampliar con: 

 Calculo de superficies de diferentes usos del suelo afectados por el peligro concreto. 
se podrá calcular las pérdidas económicas estimadas, conociendo la valoración 
económica de los cultivos, por ejemplo. 

 Inclusión de otra variable en el estudio de susceptibilidad de  movimiento de 
laderas, como la tectónica, y consideración de diferentes pesos. 

 Considerar las distintas posibilidades de clasificación de peligrosidad según la 
pendiente de las laderas y cómo influye esta elección en el resultado final. 

  Comprobar que la existencia de un puente en el río introduce un error en el 
modelo, ya que el MDT generado no reconoce el ojo del puente, lo que modifica el 
modelo de distribución del agua. 

 Etc. 
 
La información de partida que se proporciona para la realización del ejercicio es la siguiente:  

 Cartografía litológica del área de estudio en formato .shp (Litologia_Villalba.shp) 

 Tabla Excel con los valores para clasificar la resistencia mecánica de las rocas en el 
área de estudio (Resistencia_mecánica_Villalba.xls) 

 Archivos en formato .shp con información altimétrica (Villalba_cn1.shp y 
Villalba_pt_aco1.shp) del MTN25. 

 Ríos (Villalba_rios1.shp) del MTN25. 

 Área de estudio para el mapa de susceptibilidad de movimiento de ladera 
(study_area.shp) 

 
La entrega del trabajo se realiza a través del Campus Virtual, con los siguientes ficheros: 

 Informe del proyecto (flujo de trabajo y cartografía final con una breve descripción) 
en formato .pdf (Apellido_examen.pdf) 

 Proyecto ArcMap, en formato .mpk (Apellido_examen.pdf; Apellido_veg.pmk; 
Apellido_hidro.pmk) 

 Salida gráfica para Google Earth, en .kmz (Apellido_"tema".kmz) 
 

 
Periodo de realización:  3 semanas  
 

 
Tiempo requerido (estimado profesor):  8 horas 
 



 
Grado de dificultad (estimado profesor): Alta (Tipo F) 

 

VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



 

Anexo 7. Prácticas desarrolladas en la asignatura de “Informática para 

Arqueología” y resultados obtenidos 

 

 

  



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Creación de capas a partir de WEBs - IDEs 

 
Presentación:  
Se presenta de forma guiada como trabajar con las Webs que contienen capas 
georreferenciadas y con las IDEs y su aplicación a la Arqueología. ¿Qué son? ¿Cuáles son las 
más útiles? ¿Cómo utilizar su información? ¿Cómo generar nuevos datos y nuevas capas a 
partir de la información online? son algunas de las cuestiones que se abordarán. 
 

Objetivo/s:   
1. Introducir al alumnado los conceptos básicos de bases de datos espaciales. 

2. Lograr que el alumnado pueda crear capas georreferenciadas. 

3. Capacitar al alumnado en el uso de herramientas de búsqueda de datos espacial a 

un caso concreto de arqueología espacial. 

 
Conocimientos previos 
No requiere de conocimientos previos específicos. 
 
Datos y recursos necesarios 
El profesorado presentará al estudiante durante hora las Webs que contienen capas 
georreferenciadas, las IDEs y visores destacando su aplicación a la Arqueología. 
 
Actividades a realizar: 
1º Descargar -de la web del IGN- el modelo digital del terreno (MDT200) de la Comunidad 
de Madrid. 
2º Descargar la capa de Comunidades Autónomas de España de la web de Esri (ArcGIS 
online). Con ella crear una capa nueva solo de la Comunidad de Madrid. 
3º Incorporar el MDT y la capa vectorial de las comunidades autónomas a ArcMap. 
Seleccionar solo la Comunidad de Madrid y crear una nueva capa. 
Recortar el MDT con los límites de la Comunidad de Madrid.  
Descargar la capa de municipios España de la web de Esri y mediante la selección por 
atributos generar una nueva capa de una comunidad autónoma. 
4º Presentar la capa de la comunidad autónoma elegida con una escala fijada en 
1:2.000.000 
 
Pasos a seguir 
Los estudiantes han de crear un documento Word indicando los pasos seguidos y mostrando 
los resultados parciales en pantallazos y el final como composición de mapa. Este documento 
se ha de subir al espacio habilitado para ello en el Campus Virtual.  
 
 
 
 
 
 



 
Periodo de realización:  Entregar al terminar la sesión  
 

 
Tiempo requerido (estimado profesor):  60 minutos  
 

 
Grado de dificultad (estimado profesor): Media (Tipo C) 
 

 

 

VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Edición y digitalización de capas  

 
Presentación:  
El ejercicio consiste en crear, una Geodatabase que incluirá información cartográfica y 
temática de los «Edificios Históricos» de Madrid. En esa Geodatabase se va a incorporar una 
capa nueva de polígonos (Monumentos Históricos), junto a otros datos provenientes de 
cartografía ya digitalizada o con información espacial, pero en distintos formatos (CAD, Excel, 
etc.). 
La digitalización de la capa nueva se va a realizar sobre un mapa base como Open StreetMap 
En la geodatabase se van a usar herramientas para asegurar el control de calidad en la 
información a incorporar de la componente temática (mediante el uso de dominios). 
 
 

Objetivo/s:   
 

1. Lograr que los estudiantes sean capaces de crear su propia información espacial: 
cartográfica y temática.  

2. Capacitar los estudiantes en el manejo de herramientas de edición y digitalización a 
un caso concreto de arqueología espacial. 
 

 
Conocimientos previos 
Se requieren conocimientos teóricos de edición.  
 
Datos y recursos necesarios 
En ArcCatalog se mostrarán las herramientas para añadir nuevas capas u otros tipos de datos 
SIG. Con esas herramientas se va a crear una Personal Geodatabase. A la Geodatabase se le 
pondrá el nombre de “Edificios Históricos”. Una vez creada, en las > Propiedades  de la 
Geodatabase se van a definir los siguientes aspectos: 
Se crearán los dominios a aplicar después en la capa:  
Para “Monumentos”: un dominio para el número de “Visitantes” (Long Integer y mínimos de 
0 y máximo de 10000), Uso (text con valores de código: Culto, Administrativo, Militar, 
Cultural-Educativo, Parques y Jardines, Otros Equipamientos, Residencial…) y Estilo (text, con 
valores de códigos: Barroco, Neoclásico, Romántico, Ecléctico, Neobarroco, Actual…). 
Códigos para usos: 

TIPOLOGÍA USOS USOS 2000 

Culto C 

Administrativo AD 

Militar M 

Cultural-Educativo C-E 

Otros Equipamientos EO 

Parques y Jardines PyJ 

Deportivo D 

Verdes V 

Residencial R 

 



Códigos para estilo: 

ESTILO ARQUITECTÓNICO ESTILO 

Barroco BA 

Neoclásico NC 

Romántico RO 

Ecléctico ECL 

Neobarroco NB 

Actual A 

Otros O 

 
La estructura de la Geodatabase de «Edificios históricos» tendrá inicialmente una capa, 
proyectada en WGS_1989_UTM_Zone_30N. La capa tendrá estas características: 
Capa de polígonos (6-10 polígonos). 
Campos a incorporar: Nombre, Visitantes (aplicando el dominio creado), Uso (aplicando el 
dominio creado) y Estilo (aplicando el dominio creado). 
 
Actividades a realizar: 
Para digitalizar la capa se va a usar la herramienta de EDICIÓN. Se comenzará la edición con 
la capa de polígonos.  
La herramienta de > Edición está en las barras de herramientas.  
Capa de Monumentos (polígonos).- Sobre la capa de Monumentos y tomando como base para 
la digitalización Open StreetMap. Se ABRIRÁ la edición y se mostrará como digitalizar los 
polígonos, moverlos o borrarlos, y como incorporar la información temática en la base de 
datos.  Se digitalizará un primer polígono y se mostrará después las herramientas de 
autocompletar polígono, de partir polígono)… 
Una vez incorporada una serie de puntos (Monumentos), se usará la herramienta de Validate 
Features para verificar la posible existencia de errores en la introducción de los datos.  
 
Pasos a seguir 
Los estudiantes han de crear un documento Word indicando los pasos seguidos y mostrando 
los resultados parciales en pantallazos y el final como composición de mapa. Este documento 
se ha de subir al espacio habilitado para ello en el Campus Virtual.  
 
 

 
Periodo de realización:  Entregar al terminar la sesión  
 

 
Tiempo requerido (estimado profesor):  90 minutos  
 

 
Grado de dificultad (estimado profesor): Media (Tipo C) 
 

 

 

  



VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Incorporación de datos georreferenciados mediante GPS 
y visores 
 
Presentación:  
Se presenta de forma guiada cómo trabajar con la ayuda del GPS del móvil y su posterior 
visualización en visores, en los cuales además se pueden corregir los tracks representados y 
se puede digitalizar de manera georreferenciada.  
 
 

Objetivo/s:   
1. Reforzar los conocimientos teóricos de cartografía. 

2. Aproximar al uso de los GPS (aplicaciones móviles).  

3. Familiarizar a los estudiantes con el uso de los visores cartográficos. 

4. Lograr que los estudiantes puedan crear y modificar itinerarios georreferenciados.  

 
Conocimientos previos 
Se requieren conocimientos teóricos de cartografía. 
 
Datos y recursos necesarios 
El profesorado, tras recordar los conceptos básicos de cartografía (proyección, escala, 
datum…), presentan el uso de una aplicación GPS. Tomando como referencia las aplicaciones 
Oruxmaps y Mapas España, del IGN, se enseña el manejo (almacenado, grabación, etc.) para 
recoger la información relativa a un track (recorrido). Los estudiantes realizan un recorrido en 
el entorno de la facultad que posteriormente, con ayuda de los docentes, visualizarán en 
distintos visores. En ellos además se realizarán correcciones y se digitalizarán nuevos 
recorridos.  
 
Actividades a realizar: 
1º Con ayuda del GPS registrar un recorrido e imágenes georreferenciadas.  
2º Visibilizar el recorrido en un visor. 
3º Corregir el recorrido. 
4º Digitalizar un track nuevo. 
 
Pasos a seguir 
Los estudiantes han de crear un documento Word indicando los pasos seguidos y mostrando 
los resultados parciales en pantallazos y el final como composición de mapa. Este documento 
se ha de subir al espacio habilitado para ello en el Campus Virtual.  
 
 
 
 
 
 
 
 



 

 
Periodo de realización:  Entregar al terminar la sesión  
 

 
Tiempo requerido (estimado profesor):  120 minutos  
 

 
Grado de dificultad (estimado profesor): Media (Tipo C) 
 

 

VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Visores, tablas, eventos y representación cartográfica 

 
Presentación:  
Se presenta de forma semiguiada como trabajar con visores que contienen capas 
georreferenciadas y su aplicación a la Arqueología. A partir de las coordenadas tomadas con 
los visores se generaran nuevos datos y nuevas capas. A continuación se usaran técnicas de 
representación de datos. 
 

Objetivo/s:   
1. Lograr que los estudiantes se familiaricen con los visores cartográficos. 

2. Lograr que los estudiantes puedan crear bases de datos geográficas y arqueológicas 

georreferenciadas. 

3. Capacitar al alumnado en el uso de herramientas básicas de análisis espacial a un 

caso concreto de arqueología espacial. 

 
Conocimientos previos 
Manejo de bases de datos y de Excel. 
Conocimientos básicos en técnicas de representación de datos y elaboración de cartografía 
temática. 
 

Datos y recursos necesarios 
El profesorado, tras presentar información de distintos visores y la forma de conseguir 
coordenadas en Iberpix, suministrará un ejercicio guiado, donde se parte de una tabla Excel 
con los yacimientos visitables de Murcia y una capa en formato shapefile que contiene la 
división municipal de la Comunidad de Murcia. A partir de la tabla y usando ArcGis 10, se 
mostrará los pasos necesarios para crear una capa nueva de puntos con los yacimientos 
visitables de Murcia. 
Tras el ejercicio guiado se propone al estudiante crear una segunda capa de manera 
autónoma, después de buscar información de las coordenadas de los yacimientos en Internet 
y a partir de la tabla generada en Excel, crear una capa de puntos y representar cada 
yacimiento según cultura. 
 
Actividades a realizar: 
1º Con ayuda del visor Iberpix, buscar las coordenadas de los yacimientos visitables de la 
Comunidad de Madrid, con el sistema de coordenadas ETRS89 y elaborar una tabla Excel de 
dichos yacimientos con los siguientes campos: ID, coordenadas X, coordenadas Y, nombre, 
municipio, cultura y función proporcionados por la Comunidad de Madrid (Plan de 
yacimientos visitables).  
2º Crear una capa con los yacimientos visitables de la Comunidad de Madrid.  
3º Crear un mapa maquetado de los yacimientos visitables de la Comunidad de Madrid, por 
culturas, sobre la base del MDT recortado de la Comunidad de Madrid (la práctica anterior). 
 
 
 



 
Pasos a seguir 
Los estudiantes han de crear un documento Word indicando los pasos seguidos y mostrando 
los resultados parciales en pantallazos y el final como composición de mapa. Este documento 
se ha de subir al espacio habilitado para ello en el Campus Virtual.  
 

 
Periodo de realización:  Entregar al terminar la sesión  
 

 
Tiempo requerido (estimado profesor):  120 minutos  
 

 
Grado de dificultad (estimado profesor): Media (Tipo C) 
 

 

 

VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



RESULTADOS OBTENIDOS EN LA EVALUACIÓN DE LAS PRÁCTICAS EN LA 

ASIGNATURA DE “INFORMÁTICA PARA ARQUEOLOGÍA”  

 

Total de alumnos participantes: 38 

 

Tiempos dedicados por los estudiantes a las prácticas 

 Tiempo 
medio 

Mínimo Máximo Desviación típica 

Práctica 1 104 50 165 25,96 

Práctica 2 120 45 210 35,53 

Práctica 3 123 60 166 31,15 

Práctica 4 95 45 150 28,86 

Tiempo medio 111 45 210 32,62 
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Grado de dificultad  

 

 Grado dificultad Mínimo Máximo Desviación típica 

Práctica 1 2,97 2 5 0,87 

Práctica 2 3,63 1 5 0,94 

Práctica 3 2,05 1 5 0,92 

Práctica 4 3,44 2 5 0,96 

Grado medio 3,05 1 5 1,09 
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Grado de dificultad según prácticas: 
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Grado de utilidad 

Grado utilidad Mínimo Máximo Desviación típica 

Práctica 1 4,34 3 5 0,52 

Práctica 2 3,88 2 5 0,90 

Práctica 3 4,29 3 5 0,65 

Práctica 4 3,90 2 5 0,97 

Grado medio 4,15 2 5 0,80 
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Grado de utilidad según prácticas: 
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Consideras que la práctica… 
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¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has 

resuelto? 

 Sí No Ayuda del 
docente  

Compañeros De forma autónoma 

Práctica 1 26 12 20 4 0 

Práctica 2 33 5 13 7 4 

Práctica 3 10 25 7 2 0 

Práctica 4 27 9 11 14 2 

 



 

Anexo 8. Prácticas desarrolladas en la asignatura de “SIG II” y resultados 

obtenidos 

 

  



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Elaboración de un mapa de aptitud para la localización de 
un vertedero en la Comunidad de Madrid 
 
Presentación: Se trata de elaborar a partir de un análisis multicriterio un mapa de aptitud 
para la localización de un vertedero en la región de Madrid. 
Es un trabajo de carácter autónomo, no dirigido, simulando la aplicación de técnicas 
multicriterio implementadas en los SIG, para resolver problemas de localización óptima para 
un uso/actividad determinada. 
 

Objetivo/s:   
Poner en práctica los conocimientos sobre el uso de herramientas SIG raster. El alumno debe 
ser capaz de generar los criterios necesarios a partir de una información básica de partida y 
utilizar las metodologías y herramientas que ha visto durante la asignatura para la resolución 
del problema planteado. 
 

 
Actividades a realizar: 

 Aplicar la siguiente metodología EMC: Suma Lineal Ponderada 

 Normalizar variables en 10 categorías 

 CRITERIOS a utilizar y peso de los factores: 
o Usos aptos: (Peso 20%) 

 
URBANO NO APTO 

SECANO 10 

REGADIO 8 

PASTOS/PRADOS 3 

SISTEMAS AGROFORESTALES 2 

AGRICOLA CON VEGETACION NATURAL 8 

BOSQUE NO APTO 

MATORRAL 5 

FORMACINES SUPRAFORESTALES NO APTO 

ROQUEDO/SIN VEGETACION 6 

AGUA NO APTO 

 
o Pendientes <10%, siendo más aptas las más bajas. (Peso 30%) 
o Distancia a Ríos > 1000. A partir de 2000m la aptitud es máxima. (Peso 25%) 
o Accesibilidad: Distancia a las carreteras inferior a 1500 m. siendo más aptas las 

distancias más próximas (Peso 10%) 
o Alejado de Zonas Urbanas. Distancia > 1000m. A partir de 4000m. la aptitud 

es máxima. (Peso 15%) 
o  Suelos. Aptos son todos los tipos de suelos menos los aluviales.   

 
 
Para realizar el trabajo se dispone de las siguientes capas: 

 Mdtmadrid (raster) 

 Carreteras.shp (vectorial) 



 Ríos.shp (vectorial) 

 Suelos.shp (vectorial) 
 
El trabajo se entrega en un documento en PDF por el Campus Virtual. El documento debe ser 
explicativo del trabajo realizado: objetivos, metodología, herramientas y resultados. Debe 
incluir imágenes (obtenidas de ArcMap). 
 

 
Periodo de realización:  1 semana 
 

 
Tiempo requerido (estimado profesor):  3 horas 
 

 
Grado de dificultad (estimado profesor): Media (Tipo D) 
 

 

 

  



RESULTADOS 

Está práctica se ha realizado en el mes de mayo de 2017, en la Asignatura de SIG II 

correspondiente al Grado de Geografía y Ordenación del Territorio (3er curso). Se ha 

utilizado ArcGis 10 con el módulo de Spatial Analyst. 

El profesor responsable del diseño y su aplicación ha sido Miguel Vía García. 

Ha sido realizada por 11 alumnos. 

A continuación, se muestra un resumen de las valoraciones realizadas por los 

alumnos:  

 

VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 
 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 
El valor promedio es de 2,6, y la desviación típica de 0,8 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 
El valor promedio es de 2,1, y la desviación típica de 0,9 
 
 

Utilidad de la práctica (Valoración de 1 a 5):  
 
El valor promedio es de 4,6, y la desviación típica de 0,3 
 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. Un 90% 
2. Introduce contenidos nuevos: Un 20% 
3. Ha sido redundante con lo visto en clase o en otra práctica Un 50% 
4. Está bien estructurada Un 100% 

 
 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 
Las principales dificultades han sido en la elaboración de los factores y en encontrar las 
herramientas en el programa 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



 

Anexo 9. Prácticas desarrolladas en la asignatura de “Aplicaciones de las TIG en 

estudios urbanos” y resultados obtenidos 

 

 

 

 

 

 

 

 

 

 



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Creación de una red en un SIG  

 
Presentación: Se propone al estudiante crear una segunda red de manera autónoma, a partir 
de un fichero shape proporcionado por el profesorado. Los estudiantes deberán entregar un 
informe mostrando la red creada para la actividad autónoma. Se deberá demostrar su 
correcto funcionamiento mediante el cálculo de una ruta entre dos puntos, cuya localización 
se realizará de forma libre por el alumno.  
 

Objetivo/s:   
Los objetivos en términos de resultados esperables de la enseñanza son: 

1) Lograr que el estudiante identifique distintos conceptos y elementos con los que 
trabaja una red en el entorno de los Sistemas de Información Geográfica (SIG). 

2) Capacitar al estudiante en el uso de la herramienta de creación de una red en un SIG 
(en este caso ArcGIS10). 

 
Actividades a desarrollar: Vas a usar una capa shape vectorial que contienen los arcos del 
callejero de una ciudad media española. En la tabla de atributos tienes los campos de LENGHT 
y TIEMPO para introducir las impedancias de longitudes en metros y tiempos en coche en 
minutos.  

Para demostrar el buen funcionamiento de la red, calcula las rutas entre dos puntos situados 
en los extremos de la ciudad, minimizando inicialmente el tiempo en coche y después la 
longitud en metros. Muestra los pasos y resultados finales mediante pantallazos.   
 
 

 
Periodo de realización:  1 día  
 

 
Tiempo requerido (estimado profesor):  90 minutos 
 

 
Grado de dificultad (estimado profesor): Media (Tipo E) 
 

 

 

  



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Rutas óptimas entre centros de salud: uso del cálculo de 
caminos mínimos (best route) en ArcGIS 10. 
 
Presentación: Se propone al estudiante calcular rutas optimas de viajes siguiendo una 
secuencia de paradas. Se parte de la localización de centros de salud en una ciudad media y 
se va a crear una ruta óptima para el reparto de medicamentos entre los centros.  
 

Objetivo/s:   
Los objetivos en términos de resultados esperables de la enseñanza son: 

1) Lograr que el alumno sea capaz de calcular rutas óptimas en un Sistemas de 
Información Geográfica (SIG). 

2) Capacitar al alumno en el manejo de herramientas para calcular rutas óptimas en 
aplicaciones logísticas, optimizando las secuencias de paradas e introduciendo 
ventanas de tiempos en las paradas. 

 

 
Actividades a desarrollar: Vas a trabajar en una ciudad media con la red de centros de salud 
para establecer una ruta de recogida de basura biosanitaria. Tienes que fijar tiempos de 
recogida en cada centro, en una franja de tiempo limitada a la tarde. Establece también 
tiempos de recogida en cada centro. Fuerza los tiempos de manera que aparezcan violaciones 
y tiempos de espera. 

Realiza un informe con los pasos seguidos y documéntalo mediante capturas de pantalla. 
 

 
Periodo de realización:  1 día  
 

 
Tiempo requerido (estimado profesor):  90 minutos 
 

 
Grado de dificultad (estimado profesor): Media (Tipo E) 
 

 

 

  



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Cálculo de áreas de servicio/cobertura (Service area) en 
ArcGIS 10 
 
Presentación: Se van utilizar metodologías para conocer la población residente en las áreas 
de servicio de equipamientos públicos. A la hora de definir las áreas de servicio se utilizará 
análisis de redes. Se va a trabajar con áreas de cobertura a partir de desplazamientos en 
coche. Una vez definidas las franjas de cobertura se presentará la forma para obtener el 
volumen de población residente en el interior de las franjas de cobertura. 
 

Objetivo/s:   
Los objetivos en términos de resultados esperables de la enseñanza son: 

1) Lograr que el estudiante sea capaz de calcular áreas de servicio por la red un Sistemas 
de Información Geográfica (SIG). 

2) Capacitar al estudiante en el manejo de herramientas para calcular áreas de servicio 
de equipamientos públicos y privados y poblaciones cubiertas. 

 

 
Actividades a desarrollar:  
Calcula las áreas de servicio de los centros de salud de una ciudad media, trabajando con 
impedancias en metros y tres coronas de distancia: 300, 600, 900 metros. Calcula después 
una tabla con la población cubierta en cada una de esas áreas de servicio y el total de 
población que quedaría sin cubrir ¿Qué porcentaje de población de la ciudad queda a más de 
900 metros? 
 
Realiza un informe con los pasos seguidos y documéntalo mediante capturas de pantalla. 
 

 
Periodo de realización:  1 día  
 

 
Tiempo requerido (estimado profesor):  90 minutos 
 

 
Grado de dificultad (estimado profesor): Media (Tipo E) 
 

 

 

  



PRESENTACIÓN DE LA ACTIVIDAD 

Título: Cálculo de los destinos más próximos (closest facilities) 
(closest facility) en ArcGIS 10 
 
Presentación: Se va a usar la herramienta de asignación de equipamientos próximos (closest 
facility). Closest facility permite encontrar la ruta óptima desde localizaciones puntuales 
(puntos de demanda) al equipamiento o equipamientos más próximos (puntos de oferta). La 
información obtenida es la asignación del equipamiento más próximo, la distancia al mismo 
y la ruta a seguir. Se va a utilizar esta herramienta como complemento a los análisis de 
cobertura, en este caso asignando la población a los centros de salud más próximos. Vamos a 
trabajar con puntos que representan la localización de la población y que serán asignados a 
los centros de salud.  

Objetivo/s:   
Los objetivos en términos de resultados esperables de la enseñanza son: 

1) Lograr que el estudiante sea capaz de asignar localizaciones a equipamientos y 
servicios por su distancia por la red viaria un SIG. 

2) Capacitar al estudiante en el manejo de herramientas de asignación de 
equipamientos próximos y su aplicación en la planificación.  

 

 
Actividades a desarrollar:  
Realiza una asignación de las escuelas a los 3 centros de salud más próximos ¿Qué escuelas 
se encuentran en una peor situación?  
 
Realiza un informe con los pasos seguidos y documéntalo mediante capturas de pantalla. 
Representa los datos y muestra los resultados que podrían alimentar un plan de emergencias 
para las escuelas de la ciudad. 
 

 
Periodo de realización:  1 día  
 

 
Tiempo requerido (estimado profesor):  90 minutos 
 

 
Grado de dificultad (estimado profesor): Media (Tipo E) 
 

 

 

  



VALORACIÓN DE LA ACTIVIDAD POR EL ALUMNO 

 
Tiempo requerido (real, minutos dedicados a la práctica): 
 

 
Grado de dificultad (Valoración de 1 a 5): 
 

Utilidad de la práctica (Valoración de 1 a 5): 

Consideras que la práctica… (Marca las opciones que consideres) 
1. Complementa lo aprendido en clase. 
2. Introduce contenidos nuevos 
3. Ha sido redundante con lo visto en clase o en otra práctica 
4. Está bien estructurada  

 

¿Has tenido dificultades durante el desarrollo de la práctica? ¿Cómo las has resuelto? 
 

Espacio libre para señalar aquellos aspectos que consideres relevantes sobre la práctica: 
 

 



RESULTADOS OBTENIDOS EN LA EVALUACIÓN DE LAS PRÁCTICAS EN LA 

ASIGNATURA DE “APLICACIONES URBANAS EN ESTUDIOS URBANOS”  

 

Total de alumnos participantes: 8 

 

Tiempo dedicado por los estudiantes (minutos) 

Estudiantes: Práctica 1 Práctica 2 Práctica 3 Práctica 4 

1 40 40 90 45 

2 120 120 120 60 

3 45 60 60 120 

4 60 90 60 120 

5 60 120 120 40 

6 35 40 30 95 

7 45 50 40 120 

8 180 134 75 115 

Media 73,1 81,8 74,4 89,4 

Desv. Típica 50,8 39,1 33,7 35,4 

 

Grado de dificultad (valoraciones de 1 a 5) 

Estudiantes: Práctica 1 Práctica 2 Práctica 3 Práctica 4 

1 2 1 5 4 
2 3 3 3 5 
3 2 3 3 3 
4 3 4 4 3 
5 2 2 3 3 
6 2 1 2 5 
7 4 2 3 3 
8 3 5 5 5 

Media 2,6 2,6 3,5 3,9 
Desv. Típica 0,7 1,4 1,1 1,0 

 

Grado de utilidad (valoraciones de 1 a 5) 

Estudiantes: Práctica 1 Práctica 2 Práctica 3 Práctica 4 

1 5 5 5 5 

2 4 4 5 5 

3 5 5 5 5 

4 5 5 5 5 

5 5 4 5 4 

6 4 5 4 5 

7 5 4 3 5 

8 5 5 5 5 

Media 4,8 4,6 4,6 4,9 

Desv. Típica 0,5 0,5 0,7 0,4 




